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Using this Workbook
Before starting any of the projects in this manual, please visit http://www.learnkey.com/admin/files/photoshopcc.zip

and http://www.learnkey.com/admin/files/photoshopcc_project.zip and download the Photoshop CC Project Files 
that accompany this manual (you may need to scroll to the bottom of the page for the link).

The exercises in this manual serve as a companion to LearnKey’s training and are organized by session to match the 
presented concepts. Within each session, exercises are arranged from easiest to most challenging. In the Introduction 
section of each session, you will find outlines of the training and sample lesson plans which will give you an overview 
of the training content and help you to structure your lessons. The following sections are included for each session of 
training:

Skills Assessment: The skills assessment will help you and your students to gauge their understanding of course topics 
prior to beginning any coursework. Each skill listed is tied directly to an exam objective. Understanding where your 
students feel less confident will aid you in planning and getting the most from the training.

Objective Mapping and Shoot File Links: The objective mapping provides a quick reference as to where in the 
training a specific certification exam objective is covered. The Files column lists the name of the Course Support files 
(Excel spreadsheets, Photoshop files, etc.) that are used and demonstrated during the training. The files will typically 
have a starting file containing all data necessary to begin the demonstrated skill, as well as a completed file which 
shows the final result.

Keyboard Shortcuts & Tips: The keyboard shortcuts and tips provide a reference of product-specific keyboard 
shortcuts and helpful hints to make working more efficient.

Short Answer and Matching: The short answer questions facilitate a recall of the basic training concepts to further 
aid in retention of the course topics and information in preparation for the training’s Pre-Assessments, Post Tests, 
and MasterExam. The matching exercise provides additional learning reinforcement of terms and concepts found 
throughout the training in the courses’ glossary.

Projects: The projects in this manual are organized by session to match the concepts presented in the LearnKey 
training. Each project is assigned a difficulty level of either beginner, intermediate, or advanced. Some projects will 
be noted as “beginner-intermediate” or other range. Within each session, projects are arranged from easiest to most 
challenging. Each project includes a description of the task as well as steps required for successful completion. Note 
that the steps may not indicate each required action but will provide the expectation of what is required, leaving 
the action to the student. References to the concepts demonstrated in the LearnKey training that are required for 
successful completion of the project are also included. Each project will also indicate the files and software used to 
complete the tasks. Some projects may only include a file named “ProjectTitle_End.” Projects only including an end 
file typically begin with a new file which is indicated in the first step. The “ProjectTitle_End” file is included to illustrate 
a possible correct result. Other projects may include a file named “ProjectTitle_Start” or other files. Projects with a 
“ProjectTitle_Start” file begin with that file instead of a new file. “Start” files typically contain data required for the 
project pre-inserted to focus the project on concepts versus data entry. 

http://www.learnkey.com/admin/files/photoshopcc.zip
http://www.learnkey.com/admin/files/photoshopcc_project.zip
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Best Practices Using LearnKey’s Online Training
LearnKey offers video-based training solutions which are flexible enough to accommodate the private student, as well 
as educational facilities and organizations.

Our course content is presented by top experts in their respective fields and provides clear and comprehensive 
information. The full line of LearnKey products have been extensively reviewed to meet superior standards of quality. 
The content in our courses has also been endorsed by organizations, such as Certiport, CompTIA®, Cisco, and 
Microsoft. However, it is the testimonials given by countless satisfied customers that truly set us apart as leaders in the 
information training world.

LearnKey experts are highly qualified professionals who offer years of job and project experience in their subjects. 
Each expert has been certified in the highest level available for their field of expertise. This provides the student with 
the knowledge necessary to also obtain top-level certifications in the field of their choice.

Our accomplished instructors have a rich understanding of the content they present. Effective teaching encompasses 
not only presenting the basic principles of a subject, but understanding and appreciating organization, real-world 
application, and links to other related disciplines. Each instructor represents the collective wisdom of their field and 
within our industry.

Our Instructional Technology
Each course is independently created, based on standard objectives provided by the manufacturer for which the 
course was developed.

We ensure that the subject matter is up-to-date and relevant. We examine the needs of each student and create training

that is both interesting and effective. LearnKey training provides auditory, visual, and kinesthetic learning materials to 
fit diverse learning styles. The following are three levels of implementation:

Standard Training Model
The standard training model allows students to proceed through basic training, building upon primary knowledge and 
concepts to more advanced application and implementation. In this method, students will use the following toolset:

Pre-assessment: The pre-assessment is used to determine the student’s prior knowledge of the subject matter. It

will also identify a student’s strengths and weaknesses, allowing the student to focus on the specific subject matter

he/she needs to improve most. Students should not necessarily expect a passing score on the pre-assessment as it is

a test of prior knowledge.

Video training session: Each course of training is divided into sessions that are approximately two hours in

length. Each session is divided into topics and subtopics.

Post test: The post test is used to determine the student’s knowledge gained from interacting with the training. In

taking the post test, students should not consult the training or any other materials. A passing score is 80 percent

or higher. If the individual does not pass the post test the first time it is taken, LearnKey would recommend the

incorporation of external resources, such as the workbook and additional customized instructional material.
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Intermediate Training Model
The intermediate training model offers students additional training materials and activities which allows for better

retention, review, and interaction. This model includes not only the standard model material, but also includes the

following toolset:

Study guides: Study guides are a list of questions missed which can help students recognize areas of weakness

and necessary focus. They can be accessed from either the pre-assessment or post test.

Labs: Labs are interactive activities that simulate situations presented in the training. Step-by-step instructions

and live demonstrations are provided.

Workbooks: Workbooks have a variety of activities, such as glossary puzzles, short answer questions, practice

exams, research topics, and group and individual projects, which allow the student to study and apply concepts

presented in the training.

Master Training Model
The master training model offers the student an additional opportunity to prepare for certification by further 
examining his/her knowledge. This model includes the materials used in the standard and intermediate models, as 
well as the MasterExam.

MasterExam: The MasterExam draws from a large pool of questions to provide a unique testing experience each

time it is taken. LearnKey recommends a student take and pass the exam, with a score of 80 percent or higher,

four times in order to prepare for certification testing. Study guides can also be accessed for the MasterExam.
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Photoshop CC Introduction
LearnKey’s new Photoshop CC course will introduce students to hundreds of new updates and features in the 
latest Photoshop update. Whether you are a graphic designer or a novice photographer you will learn how to 
edit photographs and images, or create logos and marketing pieces. LearnKey’s Photoshop CC course will teach 
students what they need to know in order to effectively and easily prepare to test their skills through the ACA Visual 
Communication Certification exam.  

Benefits: 
•	 Learn about the hundreds of updates such as 3D exporting and printing, improved smart guides, and more!

•	 Learn and understand terminology for digital images

•	 Apply what you have learned with interactive labs, pre and post tests, and MasterExams
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Instructions: Rate your skills on the following tasks from 1-5 (1 being needs improvement, 5 being excellent).

Skills 1 2 3 4 5
Identify the purpose, audience, and audience needs for preparing 
image(s). 

Demonstrate knowledge of standard copyright rules for images and 
image use. 

Demonstrate knowledge of project management tasks and 
responsibilities. 

Communicate with others (such as peers and clients) about design 
plans. 

Demonstrate knowledge of image resolution, image size, and image 
file format for web, video, and print. 

Demonstrate knowledge of design principles, elements, and image 
composition. 

Demonstrate knowledge of color correction using Photoshop CC. 

Demonstrate knowledge of image-generating devices, their resulting 
image types, and how to access resulting images in Photoshop CC. 

Identify elements of the Photoshop CC user interface and 
demonstrate knowledge of their functions. 

Demonstrate knowledge of layers and masks. 

Demonstrate knowledge of importing, exporting, organizing, and 
saving.

Demonstrate knowledge of producing and reusing images. 

Demonstrate an understanding of and select the appropriate 
features and options required to implement a color management 
workflow. 

Demonstrate knowledge of working with selections.

Transform images. 

Adjust or correct the tonal range, color, or distortions of an image. 

Demonstrate knowledge of retouching and blending images.

Demonstrate knowledge of drawing and painting.

Demonstrate knowledge of type.

Demonstrate knowledge of filters.

Demonstrate knowledge of preparing images for web, print, and 
video.

Skills Assessment
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Photoshop CC Time Tables

Session 1 Actual Time

Intro to Photoshop CC 00:05:12

The Capture 00:23:59

Open Files in Photoshop CC 00:06:18

Navigate Documents 00:08:40

Creating a New Document 00:09:20

Color Theory and Management 00:14:19

Understanding Image Formats 00:04:48

Total Time 01:12:36

Session 2 Actual Time

Resolution and Cropping 00:17:01

Evaluate Image 00:06:55

Basic Tonal Adjustments 00:26:20

Selections 00:28:05

Basic Retouching 00:10:12

Content-Aware 00:09:06

Total Time 01:37:39

Session 3 Actual Time

Understand Layers 00:10:20

Work with Layer Masks 00:11:45

Work with Type 00:22:33

Filters 00:30:12

Shape Tool and Pen Tool 01:03:38

Total Time 02:18:28

***The actual time is calculated based on how long it will take to simply watch the video files.
***The total trianing time (inlcuding watching the videos, completing the labs, projects, and assessments) may double or even 
triple the actual time.
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Session 1



12 | Session 1 Photoshop CC Project Workbook

Session 1 Fill-in-the-Blanks
Instructions: While watching Session 1, fill in the missing words according to the information presented by the instructor. 
[References are found in the brackets.]

Intro to Photoshop CC
1.	 Project requirements include the			                       , audience, and the audience needs for image production. 

[Project Requirements]

The Capture
2.	 The Adobe 			             can automatically launch whenever a camera or card reader is connected. 

[Import Photos]

3.	 Metadata is information that is 			                   into photo images. [Metadata]

4.	 The 			                feature in the Camera Raw dialog box can be used to bring out any deep colors in an 
image. [Functions of a Camera]

5.	 The 			                image format is an uncompressed format. [Scanning an Image]

6.	 The 			                bar changes depending on which tool is currently selected. [Photoshop Workspace]

7.	 In the Window menu you can use the 			               category to configure the image display. [Configure 
Image Display]

8.	 You can use the 			                       panel to hover over an image and get color readings of the different 
portions of that image. [Panels]

9.	 You can use 			               panels to customize your workspace, however be careful that they do not cover 
your artwork. [Customize Workspace]

10.	 Keyboard shortcuts can be managed from the 			               menu. [Customize Keyboard]

Open Files in Photoshop CC
11.	 DNG is Adobe’s digital negative format that comes from higher-end digital SLR cameras and is a/an 				  

                                                         file format. [DNG Files]

12.	 The Mini Bridge panel can be accessed from the Window menu, 			                , and then clicking Mini 
Bridge. [Using the Mini Bridge]

Navigate Documents
13.	 The 			                tool is used to zoom in and out on an image. [Navigate Documents]

14.	 If you click and hold your cursor on the 			                   tool, you can access the rotate view tool. [Rotating 
the Canvas]

15.	 When using the 			                       tool, you can use spring loaded tools which temporarily activate another 
tool. [Keyboard Shortcuts for Navigation]

Creating a New Document
16.	 U.S. Paper, International Paper, and 			            are print outputs for a document. [New Document 

Window]

17.	 In the View menu, you can click 				     to set a guide at an exact point. [Rulers and Guides]

18.	 To lock and unlock guides in Photoshop CC, open the 			             menu and click Lock Guides. [Lock 
and Unlock Guides]
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19.	 The 			                category in the View menu allows you to align image documents to guides, grids, 
layers, slices, and document bounds. [Guide Properties and Using Grid]

Color Theory and Management
20.	 			                       will appear in the RGB color model when green and blue overlap. [Understanding RGB and 

CMYK]

21.	 A color 			                       defines the range of colors within a color model. [Difference Between RGB and 
CMYK]

22.	 In Photoshop CC, all of your color modes can be found under the 			                    menu in the Mode 
category. [Color Modes for Printing]

23.	 In the Color Settings menu, you can change your 			                    engine and alter the rendering intent. 
[Color Settings]

24.	 In Photoshop CC the default 			              Colors keyboard shortcut is Cmd+Y. [Render Intent and Soft 
Proofing]

25.	 In Photoshop CC, you can assign and convert profiles from the 			              menu. [Assign Profile and 
Convert to Profile]

26.	 When you print documents from Photoshop CC, you can choose to let a printer or 			                   manage 
your colors for the print job. [Color Management and Printer Setup]

Understanding Image Types
27.	 			                       and vector are the two primary graphic types used in Photoshop CC. [Graphic Types]

28.	 Vector formats include .ai, 				          , and to a lesser extent, .dwg. [Vector Formats]

29.	 JPEG, GIF, and 			                     are raster-based formats that are used in the web-based production process. 
[Print Raster and Web Raster Formats]

30.	 The 			                specialty format is used in the medical industry. [Video Raster and Specialty Formats]
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Create a Project Plan
Description: 
Images can be used as powerful tools for presenting messages. Organizations use images to inform, educate, and advertise. It is 
the designer’s job to match the client’s design and create an image that will meet the employer’s overall purpose. From start to 
finish, designing a project is a large task requiring careful planning and collaboration. If done correctly, designers will be able to 
capture the desired message and purpose of the image.

For this project, you will become familiar with the basic features and options found in Photoshop CC. You will define each term 
and how they relate to a Photoshop CC project. You will then use the knowledge you have gained from the terms to plan out a 
new project.

Steps for Completion:
1.	 View the worksheet on the next page.

2.	 Write a project plan for a portfolio including either a magazine cover, a collage, images used for a webpage, or images used 
for print advertising.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Intro to Photoshop CC: Project Requirements; Project Specifications

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

1.0 Setting Project Requirements

1.1 Identify the purpose, audience, and audience needs for preparing image(s).

1.1a Identify information that determines purpose, audience, and audience needs for image production.
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Create a Project Plan Worksheet
Instructions: Answer the questions to write a project plan for a portfolio including either a magazine cover, a collage, images 
used for a webpage, or images used for print advertising.

1.	 Define your audience:

2.	 Define the needs of the audience:

3.	 Explain the purpose of the project:

4.	 Create a basic layout of how your chosen project will be put together:
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Providing Feedback
Description: 
An essential part of any project includes gathering feedback regarding the design. Using the suggestions of many people helps 
to see that it is free of flaws and mistakes that might have been missed.

For this group project, you will communicate with others (such as peers and clients) about design plans. Identify common 
problems and issues in project management.

Steps for Completion:
1.	 Using the project you have already designed, trade with someone else. Evaluate and give feedback to one another. Explain 

the methods used to create your project. Together, identify common problems and issues that arise when creating a 
Photoshop CC project. Discuss approaches that should be avoided with creating a project.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Intro to Photoshop CC: Project Requirements; Project Specifications

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

1.0 Setting Project Requirements

1.1 Identify the purpose, audience, and audience needs for preparing image(s).

1.1a Identify information that determines purpose, audience, and audience needs for image production.
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Customize the Workspace
Description: 
The workspace is your key to success in Photoshop CC. You need to know how to customize the workspace, keyboard shortcuts, 
and menus. In this project, you will display your ability to customize the Photoshop CC workspace and make it your own.

Steps for Completion:
1.	 Open the Tree.psd Course Support file in 

Photoshop CC.

2.	 Add the Info panel and make it a floating panel. 

3.	 Add the Navigator panel and dock it by the Tools 
panel.

4.	 Create a new keyboard shortcut set titled: “My 
Shortcuts.” 

5.	 Accept the changes and save the keyboard 
shortcut set.

6.	 Change the Save option under the File menu to 
red text. 

7.	 Uncheck the visibility on the Check In option in 
the file menu and save the new menu set. Title it 
“My Menus.”

8.	 Title your new workspace “My Workspace” and 
check Keyboard Shortcuts and Menus, then save 
your workspace. 

9.	 Save your work.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 The Capture: Panels, Customize Workspace, Save Custom Workspace, Customize Keyboard, Customize Menus

Project File: Tree.psd

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

3.0 Understanding Adobe Photoshop

3.1 Identify elements of the Photoshop user interface and demonstrate knowledge of their functions.

3.1b Demonstrate knowledge of how to organize and customize the workspace.

3.1d Demonstrate knowledge of the functions of various panels.
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9.	 Locate the two other options you have chosen to colorize and do the same for them. Note: Make sure at least one is on a 
different menu other than the File menu.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 The Capture: Import Photos; Metadata; Functions of a Camera; Scanning an Image; Scanned Images; Photoshop 		
	 Workspace; Configure Image Display; Panels; Customize Workspace; Save Custom Workspace; Customize Keyboard; 		
	 Customize Menus; Deleting Presets and Favorites

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

3.0 Understanding Adobe Photoshop

3.1 Identify elements of the Photoshop user interface and demonstrate knowledge of their functions.

3.1b Demonstrate knowledge of how to organize and customize the workspace.

Customize Menus
Description: 
The menus at the top of the screen in Photoshop CC, though helpful, can be quite extensive. One way to customize your 
workspace is to colorize commands on those menu lists so they stand out. You want to do this to those commands you use 
more often and this way you will be able to find them faster amongst the other options.

For this project, you will choose three of your top utilized commands or options from the menus to colorize. 

Steps for Completion:
1.	 Open Photoshop CC.

2.	 You will colorize a total of a three 
different options. To start, colorize the 
File>Save command, and then do the 
same to two additional menu options.

3.	 Click the Edit menu.

4.	 At the bottom of the Edit menu, click the 
Menus option. 

5.	 In the Keyboard Shortcut and Menus 
dialog box, make sure the Menu For 
field is set to Application Menus.

6.	 If the File menu options are not already 
showing, click the triangle next to File 
to open its list options. Note: Simply 
collapse the File menu to navigate to 
other menus when colorizing your 
additional two options. 

7.	 Locate the Save option and select it.

8.	 In the Color column, click None. Choose 
your preferred color. 



19 | Session 1 Photoshop CC Project Workbook

The Scanned Image
Description: 
A scanner is a device you can use to create a digital image by scanning print objects. Your operating system will have built-in 
scanning software to assist with the process; however, depending on the make and model of your scanner, it may have its own 
specific software that provides even more options. In any case, it is important that you have a fundamental understanding of 
how a scanner works.

In this project, you will use a scanner to scan an image to your computer. 

Steps for Completion:
1.	 Obtain an object to scan. For example, a photo, a math assignment, an ID card, etc. 

2.	 Place the object face down in your scanner. If there is a marked area, make sure the object is not outside the lines so it will 
not be cut off. 

3.	 Depending on your scanner, you may either start the scanning process from the scanner itself or using the installed 
software. 

4.	 Often, you will have the option to select whether you are scanning an image or a document, what file format you want the 
scanned image to be in, the resolution, and the contrast. 

5.	 It is helpful to click the Preview button before you scan (if this option is available in your software) to view a preliminary 
image of what your scanned object will look like. From here, you can further adjust the settings or go ahead and scan.

6.	 Select the location you would like to save the image to on your computer, and name the file. 

7.	 Now, open Photoshop CC and use File>Open to open your scanned image and edit it.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 The Capture: Import Photos; Metadata; Functions of a Camera; Scanning an Image; Scanned Images; Photoshop 		
	 Workspace; Configure Image Display; Panels; Customize Workspace; Save Custom Workspace; Customize Keyboard; 		
	 Customize Menus; Deleting Presets and Favorites

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.5 Demonstrate knowledge of image-generating devices, their resulting image types, and how to access resulting images in Photoshop.

2.5a Demonstrate knowledge of digital photography/cameras.

2.5b Demonstrate knowledge of scanning.

2.6 Understand key terminology of digital images.  

2.6a Demonstrate knowledge of key terminology of digital images.
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5.	 Now, import your images from the camera by File>Get Photos from Camera.

6.	 If it asks, decide whether you want Bridge’s Photo Downloader to launch automatically whenever a camera or card reader is 
connected.

7.	 When Photo Downloader launches, locate your camera or memory card in the Source drop-down box. 

8.	 Choose the location of the imported images.

9.	 Create subfolders or choose None.

10.	 Set it to rename your files based on shot date, for example, or select Do not rename files.

11.	 Check the box to have them open in Adobe Bridge. 

12.	 Select the Get Media button.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Open Files in Photoshop CC: Open Files; DNG Files; Using the Mini Bridge

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.5 Demonstrate knowledge of image-generating devices, their resulting image types, and how to access resulting images in Photoshop.

2.5a Demonstrate knowledge of digital photography/cameras.

3.0 Understanding Adobe Photoshop

3.4 Demonstrate knowledge of producing and reusing images.

3.4a Identify reasons for creating and reusing images.

3.4b Identify techniques used to produce reusable images.

From Digital Camera to Photoshop CC
Description: 
To capture images in the first generation, use a digital camera. This way you can transfer them onto your computer using a 
smart card or USB cable, and then open and edit them in Photoshop CC. It is important to know how to retrieve images from 
your digital camera. There is an intermediary application called Adobe Bridge that comes with Photoshop CC, and Adobe 
Bridge lets you view all the folders on your computer. Using Adobe Bridge to store and import photos into Photoshop CC is very 
useful, and you will practice using Bridge.

In this project, you will use a digital camera provided by your instructor or one of your own and import photos into Adobe 
Bridge.  

Steps for Completion:
1.	 First, connect your camera to your computer 

with its USB cable. Or, place the camera’s 
memory card in the appropriate memory card 
slot if possible on your computer. 

2.	 Open Photoshop CC.

3.	 From the File menu, click Browse in Bridge.

4.	 Once inside Bridge, navigate to the location 
you would like to save the images to, whether 
it’s on the Desktop, in Documents or Pictures, 
etc. Create a new folder for the images in said 
location.
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Camera Raw
Description: 
When working with digital camera images in Photoshop CC, you have the option to work with camera raw images. Camera 
raw means you are working with an unprocessed image. You are essentially adjusting an image before it is processed and this 
provides flexibility. 

In this project, you will work with a camera raw image.   

Steps for Completion:
1.	 Open Photoshop CC.

2.	 Open one of the DNG images you imported in an earlier project.

3.	 Use the clipping warning in the histogram and the other features, such as exposure, contrast, clarity, vibrance, and 
saturation to adjust the image according to what you think looks best. 

4.	 Open the image directly in Photoshop CC where you can make further adjustments.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Open Files in Photoshop CC: Open Files; DNG Files; Using the Mini Bridge

Project File: N/A

Difficulty: Advanced 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.5 Demonstrate knowledge of image-generating devices, their resulting image types, and how to access resulting images in Photoshop.

2.5c Identify features of camera raw.
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Importing, Exporting, Organizing, and Saving
Description: 
It is important to understand how to import, export, organize, and save files in Photoshop CC. 

This project will allow you to practice importing, exporting, organizing, and saving files for web, print, and video in Photoshop 
CC. You will open scanned images, digital camera images, camera raw files, and video files in Photoshop CC. You will then 
briefly describe how to optimize images for print and web.  

Steps for Completion:
1.	 Open PHOTO1.jpg in Photoshop CC.

2.	 Make any changes desired to the image.

3.	 Save the image.

4.	 Export the image to Zoomify.

5.	 Scan an image.

6.	 Open the scanned image in Photoshop CC.

7.	 Using a digital camera, take two images.

8.	 Open one image as a JPG in Photoshop CC.

9.	 Open the other image as a camera raw image in Photoshop CC.

10.	 Take screen shots of each to demonstrate that you opened them in the correct format.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Open Files in Photoshop CC: Open Files; DNG Files; Using the Mini Bridge

Project File: PHOTO1.jpg

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

3.0 Understanding Adobe Photoshop

3.3 Demonstrate knowledge of importing, exporting, organizing, and saving.

3.3a Demonstrate knowledge of how to import, export, and save files.

3.3c Demonstrate knowledge of how to optimize images for print and web.
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Canvas and Rotate
Description: 
Photoshop CC gives you the ability to change the canvas size and rotate and flip images. Using the tools available in Photoshop 
CC, open an image and make size changes, rotate, and flip the image. Capture screen shots of each change. Paste screenshots to 
a Word document and save the document. 

   
Steps for Completion:
1.	 Open an image in Photoshop CC.

2.	 Select Canvas size.

3.	 Change the Canvas size.

4.	 Take a screen shot.

5.	 Use the Image rotation to alter the image.

6.	 Take a screen shot.

7.	 Save your screen shots in a Word document.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Navigating Documents: Navigating within 
Documents; Rotating the Canvas; Keyboard Shortcuts 
for Navigation

Project File: Any .jpg image

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.3 Transform images.

4.3a Demonstrate knowledge of how to change the canvas size.

4.3b Demonstrate knowledge of how to rotate, flip, and straighten an image and how to rotate a canvas.



24 | Session 1 Photoshop CC Project Workbook

Creating Documents and Using Rulers and 
Guides
Description: 
It does not get any more basic than creating a new document. Rulers and guides are used to help you manage your artwork so 
everything is always in order. In this project, you will learn how to create a new document. You will also learn how to activate 
rulers and guides and manage guide properties. 

   
Steps for Completion:
1.	 Open Photoshop CC, then the File menu, and then click New.

2.	 Use Photo as the default preset and change the size to Landscape, 8 x 10, then click OK.

3.	 Open the View menu and click Rulers.

4.	 Right-click on one of the rulers and click Pixels.

5.	 Create one horizontal and one vertical guide by clicking and dragging the horizontal and vertical rulers.

6.	 Open the View menu and click New Guide.

7.	 Position the new guide at 500 and click OK.

8.	 Open the Photoshop menu and click Guides, Grids, & Slices. 

9.	 Change the color of your guides to green and change the style to dashed lines.

10.	 Open the View menu and click Lock Guides.

11.	 Save your work.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Creating a New Document: Create New Document; New Document Window; Rulers and Guides; Lock and Unlock 		
	 Guides

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.2 Use Photoshop CC guides and rulers.

4.2a Demonstrate knowledge of how to show and hide rulers.

4.2b Demonstrate knowledge of how to add and remove guides.

4.2c Demonstrate knowledge of guide properties.

4.2d Demonstrate knowledge of how to change the measurement unit on rulers.
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Snap To It
Description: 
Photoshop CC allows you to place an image within another image. The Snap To option allows users to align pictures more 
accurately within the other image. For this project, you will take two images and place one image within the other image using 
rulers, guides, and the Snap To tool. 

   
Steps for Completion:
1.	 Open two images in Photoshop CC.

2.	 Open the screen in the 2-up vertical.

3.	 Drag horizontal and vertical rulers to a desired location.

4.	 Utilize the Snap To feature and make sure the Guides option is selected.

5.	 Place the second image inside the first image and snap it to the guides.

6.	 Save the new image.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Creating a New Document: Create New Document; New Document Window; Rulers and Guides; Lock and Unlock 		
	 Guides; Guide Properties and Using Grid

Project File: N/A

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.2 Use Photoshop guides and rulers.

4.2a Demonstrate knowledge of how to show and hide rulers.

4.2b Demonstrate knowledge of how to add and remove guides.

4.2c Demonstrate knowledge of guide properties.

4.2d Demonstrate knowledge of how to change the measurement unit on rulers.
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Color Management
Description: 
Color management provides many benefits, like the fact that the colors in imported images appear as the creators of the images 
intended. You have more control over how colors are blended within your project. This includes everything from motion blur to 
anti-aliasing.

 
For this project, you will identify the meanings of terms associated with color management. You will then explain the purpose 
of different options in the Color Settings dialog box and explain the difference in effects of when a user chooses either the Edit 
> Assign Profile, or Edit > Convert to Profile commands. Last, you will explain functions of settings in the Color Management 
section of the Print dialog box. 

   
Steps for Completion:
1.	 Use the worksheet on the next page.

2.	 In Part 1, define the terms associated with color management.

3.	 In Part 2, explain the difference in the way the following commands affect an image: Edit>Assign>Profile command or 
Edit>Convert to Profile.

4.	 In Part 3, define the purpose of the settings listed.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Color Theory and Management: Understanding RGB and CMYK; Difference between RGB and CMYK; Color Modes for 	
	 Printing; Color Settings; Render Intent and Soft Proofing; Assign Profile and Convert to Profile; Color Management and 	
	 Printer Setup

Project File: N/A

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.4 Demonstrate knowledge of color correction using Photoshop.

2.4e Demonstrate knowledge of how to assess color in images by using the Info panel, the Histogram panel, and color  views.

3.0 Understanding Adobe Photoshop

3.5 Demonstrate an understanding of and select the appropriate features and options required to implement a color management workflow.

3.5a Given a term associated with color management, explain the meaning of that term.

3.5b Given an option in the Color Settings dialog box, explain the purpose of that option.

3.5c Explain the differences between, and how choosing either the Edit>Assign Profile or Edit>Convert to Profile commands affects an image.
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Color Management Worksheet
Instructions: After watching Session 1, answer the questions according to the information presented by the instructor.

Part III. Define the purpose of the settings listed.

1.	 Printer Profile:

Part I. Define the terms associated with color management.

1.	 Soft Proof:

Part II. Explain the difference in the way the following commands affect an image.

1.	 Edit>Assign>Profile:

2.	 Color Gamut:

3.	 Color Spaces: 4.	 Rendering Intent:

2.	 Edit>Convert to Profile:

2.	 Color Handling:

3.	 Black Point Compensation:
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Color Theory and Management
Description: 
When it comes to Photoshop CC, you really have a lot of color modes, settings, and profiles to choose from. Understanding 
these principles will make you an expert with Photoshop CC. In this project, you will demonstrate your knowledge of color 
modes, settings, and profiles. 

   
Steps for Completion:
1.	 Open the Sunset Cliffs.psd Course Support file and open the Image menu. Hover over Mode.

2.	 Cycle through the CMYK, RGB, and Grayscale color modes. 

3.	 Open the Edit menu and click Color Settings.

4.	 Change the RGB setting from Preserve Embedded Profiles to Convert to Working RGB.

5.	 Click More Options and change the conversion engine to Apple CMM and the rendering intent to Perceptual.

6.	 Open the Edit menu and click Assign Profile.

7.	 Select a new profile in the Profile drop-down menu and click OK.

8.	 Open the Edit menu and click Convert to Profile.

9.	 Select a new profile in the Profile drop-down menu and click OK.

10.	 Open the File menu and click Revert to undo the conversion.

11.	 Save your work.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Color Theory and Management: Understanding RGB and CMYK; Difference between RGB and CMYK; Color Modes for 	
	 Printing; Color Settings; Render Intent and Soft Proofing; Assign Profile and Convert to Profile; Color Management and 	
	 Printer Setup

Project File: Sunset Cliffs.psd

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.4 Demonstrate knowledge of color correction using Photoshop.

2.4a Identify the differences between RGB and CMYK.

3.0 Understanding Adobe Photoshop

3.5 Demonstrate an understanding of and select the appropriate features and options required to implement a color management workflow.

3.5a Given a term associated with color management, explain the meaning of that term.

3.5b Given an option in the Color Settings dialog box, explain the purpose of that option.

3.5c Explain the differences between, and how choosing either the Edit > Assign Profile or Edit > Convert to Profile commands affects an image.

3.5d Given a setting in the Color Management section of the Print dialog box, explain the purpose of that setting.
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Managing Color Settings
Description: 
Images can be optimized for many mediums. It 
is important for a designer to know which color 
settings to use in order to have a professional-
looking product. The RGB color mode is typically 
used for web images and videos. The CMYK color 
mode is typically used for images that are to be 
printed.

For this project, you will change an image by using 
the Custom preset. Customize the image by setting 
the width and height. Then prepare the image so 
it will print in CMYK color with a resolution of 
300 pixels. Finally, you will convert the image to 
grayscale. 

   
Steps for Completion:
1.	 Create a new project in Photoshop CC.

2.	 Use the Custom preset.

3.	 Set the width to eight inches and the height to four inches.

4.	 Make the color mode CMYK color.

5.	 Set the resolution to 300 pixels/inch.

6.	 Import the image Lighthouse.jpg.

7.	 Convert the image to grayscale.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Color Theory and Management: Understanding RGB and CMYK; Difference between RGB and CMYK; Color Modes for 	
	 Printing; Color Settings; Render Intent and Soft Proofing; Assign Profile and Convert to Profile; Color Management and 	
	 Printer Setup

Project File: Lighthouse.jpg

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.4 Demonstrate knowledge of color correction using Photoshop.

2.4b Demonstrate knowledge of appropriate color settings for web, print, and video.

2.4f Demonstrate knowledge of how to select the appropriate color modes for web, print, and video.
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Digital Image Terminology
Description: 
Digital imaging refers to the act of producing digital images or photographs, through the use of editing and computer image 
editing software. Digital imaging involves several activities, like the processing of the images as well as compression, printing, 
storage, and display. As a rule, cameras or other photographic devices are used to capture a physical scene and transform it into 
a digital image. The image can also be produced from an analog image.

This project is designed to help you become familiar with terms which are used when working with digital images in Photoshop 
CC.  

   
Steps for Completion:
1.	 Use the worksheet on the next page. 

2.	 Define each term.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Understanding Image Formats: Graphic Types; Vector Formats; Print Raster and Web Raster Formats; Video Raster 		
	 and Specialty Formats; Microsoft

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.5 Demonstrate knowledge of image-generating devices, their resulting image types, and how to access resulting images in Photoshop.

2.5a Demonstrate knowledge of digital photography/cameras.

2.5b Demonstrate knowledge of scanning.

2.5c Identify features of camera raw.

2.5d Identify the differences between scanned images, digital camera images, and camera raw.

2.6 Understand key terminology of digital images.

2.6a Demonstrate knowledge of key terminology of digital images.
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Term Definition

Type

Pixel

Raster

Vector

Object

Bitmap

Render

Path

Resolution

Digital Image Terminology Worksheet
Instructions: After watching Session 1, define each term according to the information presented by the instructor.
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Image File Formats
Description: 
The elements which determine the total number of pixels along an image’s width and height are called pixel dimensions. 
Resolution is the caliber of detail in a bitmap image and is measured in pixels per inch (ppi). The more pixels per inch, the 
greater the resolution, and generally an image with a higher resolution produces a better printed image quality.

This project will allow you to exhibit your knowledge of image resolution, image size, and image file format for the web, 
video, and print. You will discover how image resolution can change once an image is manipulated. Then describe the 
difference between printed images and onscreen images; identify appropriate image formats for the web, video, photos, 
print, PowerPoint, or Word; explain the difference in measuring an image in pixels as opposed to inches; and explain image 
optimization with regard to preparing images for web, video, or print.  

   
Steps for Completion:
1.	 Use the worksheet on the next page.

2.	 Define the terms: resampling, cropping, ppi, dpi, and line screen frequency as they relate to Photoshop CC. 

3.	 Define the characteristics of printed images and onscreen images.

4.	 Identify the appropriate image format for web, video, photos, print, Microsoft PowerPoint, and Word.

5.	 Explain the difference in measuring an image in pixels as opposed to inches.

6.	 Write an explanation of how to optimize an image when preparing the image for web, video, or print.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Understanding Image Formats: Graphic Types; Vector Formats; Print Raster and Web Raster Formats; Video Raster 		
	 and Specialty Formats; Microsoft

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.1 Demonstrate knowledge of image resolution, image size, and image file format for web, video, and print.

2.1a Demonstrate knowledge of how image resolution can change once an image is manipulated.

2.1d Identify the difference between image size measured in pixels and document size measured in inches.
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1.	 Define the terms as they relate to Photoshop CC:

a.	PPI:

Image File Formats Worksheet
Instructions: After watching Session 1, complete the short answer questions according to the information presented by the 
instructor.

b.	DPI:

c.	Cropping:

d.	Resampling:

e.	Line Screen:

2.	 Define the characteristics of printed images and onscreen images.

3.	 Identify the appropriate image formats for:

a.	web:

b.	 print: 

c.	videos:

d.	 photos: 

e.	Microsoft Word:

f.	  Microsoft PowerPoint:

4.	 Explain the difference in measuring an image in pixels as opposed to inches.

5.	 Write an explanation on how to optimize an image when preparing the image for web, video, or print.
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Print, Web, and Video
Description: 
Another great feature of Photoshop CC is Mini Bridge. This option allows you to view and save images for various reasons. 
Images are used in three major areas: print, websites, and video. 

For this project, you will use Mini Bridge to save three images to be used for print, web, or video. As you save each image, ensure 
that the image is suitable for the specific file type you are saving it as. For example, when saving an image for print it should 
probably be a vector image in case the end user wants a larger image.   

   
Steps for Completion:
1.	 Open Mini Bridge.

2.	 Select the desired image.

3.	 Make any needed changes to be used for print.

4.	 Save the image for print.

5.	 Select another desired image.

6.	 Make any changes so the image can be used for a website.

7.	 Save the image for a website.

8.	 Select a third desired image.

9.	 Make any changes necessary so the image may be used in a video.

10.	 Save the image for a video.

Reference:
LearnKey’s Photoshop CC Training, Session 1: 

	 Understanding Image Formats: Graphic Types; Vector Formats; Print Raster and Web Raster Formats; Video Raster 		
	 and Specialty Formats; Microsoft

Project File: Any .jpg images

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

5.0 Publishing Digital Images by Using Adobe Photoshop

5.1 Demonstrate knowledge of preparing images for web, print, and video.

5.1a Demonstrate knowledge of the elements of web images that need to be checked or confirmed prior to publishing to the web.

5.1b Demonstrate knowledge of creating a Web Photo Gallery.

5.1c Demonstrate knowledge of the elements of images that need to be checked or confirmed prior to print  publishing.

5.1d Demonstrate knowledge of the elements of images that need to be checked or confirmed prior to publishing for use in videos.
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Session 2
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Session 2 Fill-in-the-Blanks
Instructions: While watching Session 2, fill in the missing words according to the information presented by the instructor. 
[References are found in the brackets.]

Resolution and Cropping 
1.	 The Image Size dialog box gives the size in				      , as well as in inches. [Understanding Resolution 

and Cropping] 

2.	 In the Canvas Size dialog box, the 				        at the bottom will determine how the canvas will grow. 
[Canvas Size] 

3.	 You can crop your image by adjusting the 			                       size. [Crop Image] 

4.	 When you send the image to a printer, the image is measured in 			                per inch. [Image 
Resolution]

5.	 In the Image Size dialog box, when you choose Preserve Details, you do have the capability to reduce the			 
				        . [Image Resolution]

6.	 If you want to commit a crop, you can click the checkmark, or you can hit the 				         key on your 
keyboard. [Crop] 

7.	 In the 			                    drop-down menu, you can choose to determine a certain size with a certain 
resolution, but you want to be careful because that will resample the image. [Resample Image] 

Evaluate Image 
8.	 The Histogram represents all the different 			                       of the image. [What is a Histogram?]

9.	 When you 			            a histogram in the Histogram panel, it will show you the Level, Count, and 
Percentile. [Histogram Panel] 

10.	 What is beneficial about the histogram on your camera, is that you can evaluate your 				         in the 
field. [Histogram on Camera] 

Basic Tonal Adjustments
11.	 Auto Tone maximizes the 				         range of each channel to produce a more dramatic correction. 

[Auto Adjustment Options] 

12.	 If you want to brighten the image, you can 			              	     the exposure. [Manual Tonal Adjustments] 

13.	 If you open the Curve Display option, you can display the light or the				          . [Levels and Curves] 

14.	 The 			                option in the Auto Color Correction Options dialog box is what Auto Contrast 
performs. [Auto Color] 

15.	 Photoshop CC has a number of advanced tonal adjustment tools that we can use for adjusting both tone and 			 
				         in images. [Tonal Adjustments] 

16.	 The Gradient 			                 maps the tones in your image to the tones in the gradient of your choosing. 
[Gradient Map] 

17.	 Posterize allows you to minimize the number of 			                  in an image. [Posterize] 

18.	 You may want to use the Localized Color Clusters if you’re trying to 			                       the color to a certain 
area of the photo. [Replace Color] 
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Selections
19.	 The purpose of a selection is to 			                   a part of the image. [Create Basic Selections] 

20.	 If you hold the 			                    key in Windows, you can subtract from a selection. [Subtract, Transform 
Selection] 

21.	 If you need to access a saved selection, you can go to Select, then Load Selection, and then choose the 				  
			                         you want to load. [Save, Fill Selection, Copy] 

22.	 The Lasso tool is much better at 			                     existing selections. [Selection Tools] 

23.	 While using the Magic Wand, you can			               +click to add to a selection. [Magic Wand] 

24.	 The Quick Selection tool utilizes a 				         tip. [Quick Selection Tool] 

25.	 The Feather Selection 			                   the edges. [Feather Selection Tool] 

26.	 The Color Range dialog box allows you to 			                      a specific color. [Color Range, Lasso Tool 
Selection] 

Basic Retouching 
27.	 One thing that we can do to 		    	           items and add items is to use the Clone Stamp tool. [Clone 

Stamp Tool] 

28.	 The Healing Brush tool will pick up the 			                   from your source area, but maintain the color in the 
destination. [Healing Brush Tool] 

29.	 Instead of selecting a 			                 and destination, I just click on the area. [Spot Healing Brush Tool] 

30.	 The Dodge tool reduces the amount of exposure on an area, and, therefore, makes the section		                                                     	
                                                           . [Blending Tools]  

Content-Aware 
31.	 You can turn the Caps Lock key on, and that will give you a more 			                  curser. [Content-Aware 

Fill] 
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Resolution and Cropping
Description: 
The aesthetics of an image can be improved though resolution and cropping techniques. Cropping an image is at the very 
foundation of enhancing a photo and adjusting objects. Once you become proficient at cropping an image, you will be better 
able to adjust the image.

Steps for Completion:
1.	 Open the Black Eyed Susan.psd Course Support file in Photoshop CC. 

2.	 Use the Canvas Size dialog box to increase the width to eight inches and the height to seven inches with the anchor at the 
center of the image. 

3.	 Select the Crop tool by clicking the Crop tool icon. 

4.	 Decrease the size of the image by grabbing the handles on the image. 

5.	 Clear the Delete Cropped Pixels option. 

6.	 Change the grid type to a Triangle grid. 

7.	 Re-sample the image to 4 x 5 in 300 ppi using the Ratio drop-down menu. 

8.	 Commit your work. 

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Resolution and Cropping: Understand Resolution and Cropping; Canvas Size; Crop Image; Image Resolution; Crop; 		
	 Resample Image; Straighten Image; Aspect Ratio; Fill and Rotate Canvas

Project File: Black Eyed Susan.psd

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images 

2.1 Demonstrate knowledge of image resolution, image size, and image file format for web, video, and print. 

2.1a Demonstrate knowledge of how image resolution can change once an image is manipulated. 

4.0 Manipulating Images by Using Adobe Photoshop 

4.3 Transform images. 

4.3a Demonstrate knowledge of how to change the canvas size. 

4.3f Identify the differences between resampling and cropping. 

4.3h Demonstrate knowledge of how to crop an image.
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Using the Histogram Panel
Description: 
Histograms are used to represent the colors found in an image. Images can be analyzed simply by looking at the histogram 
without even seeing the image. Shadows show up on the left of the histogram, and highlights show up on the right.

For this project, you will use the Histogram panel to apply AutoTone to an image.  

Steps for Completion:
1.	 Open Lighthouse.jpg in Photoshop CC.

2.	 Open and expand the histogram panel.

3.	 Analyze the image’s color properties according to the histogram.

4.	 Apply the AutoTone feature from under the Image tab. 

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Evaluate Image: What is a Histogram?; Histogram Panel; 
Histogram on Camera

Project File: Lighthouse.jpg

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.4 Demonstrate knowledge of color correction using Photoshop.

2.4c Demonstrate knowledge of how to analyze and change the tonal range of an image by 

using a histogram.

2.4d Demonstrate knowledge of how to interpret color in an image by using the Histogram 

panel.

2.4e Demonstrate knowledge of how to assess color in images by using the Info panel, the 

Histogram panel, and color views.



40 | Session 2 Photoshop CC Project Workbook

Auto and Manual Adjustments
Description: 
Adjusting tone and color in images in many different ways is one of the valuable strengths of Photoshop CC. Different settings 
allow you to correct and enhance images. Photoshop CC has the ability to utilize manual tonal adjustment techniques as well 
as auto controls.

For this project, you will demonstrate basic knowledge of many of the auto adjustment settings available in Photoshop CC as 
well as some manual techniques.  

Steps for Completion:
1.	 Use the worksheet on the next page.

2.	 Complete the short answer questions about adjustment features. 

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Basic Tonal Adjustments: Auto Adjustment Options; Manual Tonal Adjustments; Levels and Curves; Auto Color; Tonal 		
	 Adjustments; Gradient Map; Photo Filter; Posterize; Match Color; Replace Color; Selective Color; Black and 			 
	 White; Adjustment Layers; Grayscale, Hue/Saturation

Project File: N/A

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.4 Demonstrate knowledge of color correction using Photoshop.

2.4c Demonstrate knowledge of how to analyze and change the tonal range of an image by using a histogram.

4.0 Manipulating Images by Using Adobe Photoshop

4.4 Adjust or correct the tonal range, color, or distortions of an image.

4.4a Identify auto correction methods and tools that are used for adjusting tonal range.

4.4b Identify adjustment menu tools that are used for adjusting tone.

4.4c Identify advanced adjustment and correction tools and when to use them.

4.4d Identify situations where using manual tonal adjustment is more appropriate than the auto controls.

4.4f Demonstrate knowledge of how to adjust hue and saturation.
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1.	 What is a histogram?

Auto and Manual Adjustments Worksheet
Instructions: After watching Session 2, complete the short answer questions about adjustment features according to the 
information presented by the instructor.

2.	 Discuss the differences between Auto Tone, Auto Contrast, and Auto Color.

a.	 Auto Tone:

b.	 Auto Contrast: 

c.	 Auto Color:

3.	 Explain the Levels feature and how it is used.

4.	 Identify situations where using manual tonal adjustment is more appropriate than the auto controls.

5.	 Explain why correcting an image is subjective.

6.	 Explain the Curves feature and how it is used.

(continued on next page)
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7.	 What is Vibrance and how does it work?

8.	 What is Hue/Saturation and how does it work?
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Saturation, Color Balance, Vibrance, and Shadow/Highlights 
settings.

In this project, you will demonstrate your ability to enhance the 
quality of an image using the tools available in the Image menu 
and the Adjustment options. Open the image Babygirl2.jpg. As 
you can see, the image has some dark areas which obscure part 
of the face. Use the Image menu to make adjustments to the 
image to improve quality by using Hue/Saturation, Color Balance, 
Vibrance, and Shadow/Highlights. Use screen shots to show what 
changes you make to the image, and then save the image.

Steps for Completion:
1.	 Open Babygirl2.jpg in Photoshop CC.

2.	 Adjust the Hue/Saturation.

3.	 Take a screen shot of the Hue/Saturation window.

4.	 Adjust the Color Balance.

5.	 Take a screen shot of the Color Balance window.

6.	 Adjust the Vibrance.

7.	 Take a screen shot of the changes made.

8.	 Adjust the Shadow/Highlights.

9.	 Take a screen shot of the Shadow/Highlights window.

10.	 Save the changes to the image. 

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Basic Tonal Adjustments: Auto Adjustment Options; 
Manual Tonal Adjustments; Levels and Curves; Auto Color; Tonal 
Adjustments; Gradient Map; Photo Filter; Posterize; Match Color; 	
Replace Color; Selective Color; Black and White; Adjustment 
Layers; Grayscale, Hue/Saturation

Project File: Babygirl2.jpg

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.4 Adjust or correct the tonal range, color, or distortions of an image.

4.4a Identify auto correction methods and tools that are used for adjusting tonal range.

4.4b Identify adjustment menu tools that are used to adjusting tone.

4.4e Demonstrate knowledge of how to match, mix, and replace color by using a 

Image Adjustment
Description: 
Photoshop CC gives you the ability to make changes to an image and to enhance the quality of the image by using Hue and 

specific set of tools.

4.4 f Demonstrate knowledge of how to adjust hue and saturation.

4.4g Demonstrate knowledge of how to enhance the visibility of a selected feature in an image, so the feature may be examined more accurately in medical or 			 

	 scientific research, architecture, or engineering.

4.4i Demonstrate knowledge of how to apply tonal and color changes by using the Adjustment layers.
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Tonal Adjustments
Description: 
While having a good understanding of what the tones are in an image by viewing the histogram is important, you can also make 
adjustments to those tones using a number of different tools found in Photoshop CC. Some of the tools can be used to correct 
color and others to create different creative situations. 

Use this project to discover some of the tools available for making some more controlled and advanced color adjustments 
inside of Photoshop CC.

Steps for Completion:
1.	 Open the Tractor.psd Course Support file. 

2.	 Use the Replace Color dialog box to select the red 
colors in the image. 

3.	 Increase the Fuzziness to include more red tones 
in the image. 

4.	 Increase the saturation of the image to an 
appropriate level by using the Saturation slide in 
the Replace Color dialog box. 

5.	 Use the Selective Color dialog box to select the red 
colors in the image. 

6.	 Increase the Magenta in the image by using the 
Magenta slide in the Selective Color dialog box. 

7.	 Use the Layers panel to create a black and white 
layer to the panel. 

8.	 Posterize the image, and set the levels to 10. 

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Basic Tonal Adjustments: Auto Adjustment Options; Manual Tonal Adjustments; Levels and Curves; Auto Color; Tonal 		
	 Adjustments; Gradient Map; Photo Filter; Posterize; Match Color; Replace Color; Selective Color; Black and 			 
	 White; Adjustment Layers; Grayscale, Hue/Saturation

Project File: Tractor.psd

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop 

4.4 Adjust or correct the tonal range, color, or distortions of an image. 

4.4c Identify advanced adjustment and correction tools and when to use them. 

4.4e Demonstrate knowledge of how to match, mix, and replace color by using a specific set of tools. 

4.4f Demonstrate knowledge of how to adjust hue and saturation. 

4.4i Demonstrate knowledge of how to apply tonal and color changes by using Adjustment layers. 
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Selection Tools
Description: 
Selections are a powerful way to control which areas of an image you want to affect or adjust. Photoshop CC has a large variety 
of tools to make changes to an image.

For this project, you will give a brief description of each of the different selection tools. 

Steps for Completion:
1.	 Use the worksheet on the next page.

2.	 Describe the tools, where they can be found, and how each tool functions. 

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Selections: Create Basic Selections; Subtract, Transform Selection; Move Tool; Save, Fill Selection, Copy; Selection 		
	 Tools; Magic Wand; Quick Selection Tool; Advanced Selections; Feather Selection Tool; Color Range, Lasso 			 
	 Tool Selection; Hue and Saturation Adjustments; Create a Layer Mask; Copy and Paste Selection; Truer Edge 			 
	 Technology; Refine Edge Tool; Adjustment Layers

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop 

4.1 Demonstrate knowledge of working with selections.

4.1a Demonstrate knowledge of making selections using a variety of tools. 
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1.	 Rectangular Marquee tool:

2.	 Elliptical Marquee tool:

3.	 Single Row Marquee and Single Column Marquee tools:

4.	 Lasso tool:

5.	 Quick Selection tool:

6.	 Magic Wand tool:

Selection Tools Worksheet
Instructions: After watching Session 2, describe the different Selection tools, where they can be found, and how each tool 
functions according to the information presented by the instructor.
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Selection Techniques
Description: 
Photoshop CC has several different tools which help users make selections of different areas of an image. 

This project will help you recognize which tools or methods were used to make modifications or selections to an image. 

Steps for Completion:
1.	 Use the worksheet on the next page.

2.	 Explain which tools or methods were used on each of the images. 

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Selections: Create Basic Selections; Subtract, Transform Selection; Move Tool; Save, Fill Selection, Copy; Selection 		
	 Tools; Magic Wand; Quick Selection Tool; Advanced Selections; Feather Selection Tool; Color Range, Lasso 			 
	 Tool Selection; Hue and Saturation Adjustments; Create a Layer Mask; Copy and Paste Selection; Truer Edge 			 
	 Technology; Refine Edge Tool; Adjustment Layers

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop 

4.1 Demonstrate knowledge of working with selections.

4.1a Demonstrate knowledge of making selections using a variety of tools. 
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1.	

Selection Techniques Worksheet
Instructions: After watching Session 2, explain which tools or methods were used on each of the four images according to the 
information presented by the instructor.

Method(s) used:
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2.	

Method(s) used:
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3.	

Method(s) used:
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4.	

Method(s) used:
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Saving Selections
Description: 
Photoshop CC’s powerful Selection tools are one of its key components. Selections can be as basic as a square or circle, or 
as complex as the leaves on a tree. Often when working with clients, the same image is used many times simply with subtle 
variations. Re‐creating a complex selection can be time consuming. Saving selections can eliminate this wasted time. In this 
project, students will save and recall selections and then view the saved selection as a channel. 

Steps for Completion:
1.	 Open the SavingSelections_start.psd file.

2.	 Using any of the various selection tools (Marquee tool(s), Lasso tool, Magic Wand tool, etc.) select an element of the photo 
(we chose to select the hammer).

3.	 Save the completed selection as “hammer.”

4.	 Use Ctrl or Cmd+D to close the selection.

5.	 Load the saved selection from the Select menu.

6.	 Open the Channels palette to view the hammer channel.

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Selections: Create Basic Selections; Subtract, Transform Selection; Move Tool; Save, Fill Selection, Copy; Selection 		
	 Tools; Magic Wand; Quick Selection Tool; Advanced Selections; Feather Selection Tool; Color Range, Lasso 			 
	 Tool Selection; Hue and Saturation Adjustments; Create a Layer Mask; Copy and Paste Selection; Truer Edge 			 
	 Technology; Refine Edge Tool; Adjustment Layers

Project File: SavingSelections_start.psd, SavingSelections_end.psd

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop 

4.1 Demonstrate knowledge of working with selections.

4.1a Demonstrate knowledge of making selections using a variety of tools. 
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Advanced Selection Techniques
Description: 
Photoshop CC offers many advanced features for making selections, such as transforming selections, the Lasso tools, color-
based selections, and Quick Mask Mode. 

In this project, you will gain experience with various types of selections and selection tools.  

Steps for Completion:
1.	 Open the image Selctions01.jpg in Photoshop CC.

2.	 Make a selection of the photo on the left using 
the Selection Marquee tool and transform the 
selection. Save the selection.

3.	 Make a selection of the photo on the right using 
the Polygonal Lasso tool. Save the selection.

4.	 Open the image Selections02.jpg.

5.	 Make a color-based selection of the round eyeball 
excluding the whites of the eye. Save the selection.

6.	 Open the image Selections03.jpg.

7.	 Make a selection of the Christmas tree and Santa 
Claus excluding the background using Quick Mask 
Mode. Save the selection.

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Selections: Create Basic Selections; Subtract, Transform Selection; Move Tool; Save, Fill Selection, Copy; Selection 		
	 Tools; Magic Wand; Quick Selection Tool; Advanced Selections; Feather Selection Tool; Color Range, Lasso 			 
	 Tool Selection; Hue and Saturation Adjustments; Create a Layer Mask; Copy and Paste Selection; Truer Edge 			 
	 Technology; Refine Edge Tool; Adjustment Layers

Project File: Selections01.jpg, Selections02.jpg, Selections03.jpg

Difficulty: Advanced 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.1 Demonstrate knowledge of working with selections.

4.1a Demonstrate knowledge of making selections using a variety of tools.

4.1b Demonstrate knowledge of saving, loading, and editing selections.

4.1d Demonstrate knowledge of selection commands and how to modify selections.

4.1e Identify when to use feathering and anti-aliasing when making selections.

4.1f Identify tools that are used for selection.

4.1g Demonstrate knowledge of how to make selections based on a color range.

4.3 Transform images.

4.3d Demonstrate knowledge of how to scale, rotate, or skew a selection.
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Retouching and Blending
Description: 
Photoshop CC offers users many options for retouching and blending images. 

For this project, you will become familiar with a variety of different ways to correct flaws in photographs and manipulate 
photographic images.  

Steps for Completion:
1.	 Open PHOTO4.JPG in Photoshop CC.

2.	 Use the Red Eye tool to correct any red eye flaws.

3.	 Use the Healing and Spot Healing Brushes to remove the veins on the head and remove some of the shine of the nose and 
above the left eyebrow.

4.	 Use the Clone tool to clone portions of the red rug to cover the green carpet, and remove the shadow in the top left corner.

5.	 Use the Patch tool to remove the brown leg (on the left) from the image.

6.	 Use the Sharpen tool to fix edges around the baby’s head and along the rug and carpet line.

7.	 Save the image.

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Basic Retouching: Clone Stamp Tool; Healing Brush Tool; Spot Healing Brush Tool; Blending Tools; Remove Red Eye

Project File: PHOTO4.JPG

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.5 Demonstrate knowledge of retouching and blending images.

4.5a Demonstrate knowledge of retouching and blending images.

4.5b Demonstrate knowledge of removing imperfections.

4.5c Demonstrate knowledge of how to clone part of an image.

4.5d Demonstrate knowledge of how to move or extend a selected object to a new location in the image.

4.5e Demonstrate knowledge of how to sharpen an image.
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Content-Aware Features
Description: 
Over time, content-aware features have been added to Photoshop CC. Now in Photoshop CC, a feature called Content-Aware 
Move makes it even easier to move or remove parts of an image. 

For this project, you will use Content-Aware Fill and the Content-Aware Move tool.    

Steps for Completion:
1.	 Open the image ContentAware01.jpg in Photoshop CC.

2.	 First, remove the person from the image. Make a general 
selection around him using the Lasso tool. Then, press 
Shift+Backspace, or click Edit > Fill, and choose Content-
Aware.

a.	 Watch as Photoshop CC analyzes the section of the 
photo and automatically fills it for you. 

3.	 Save the image as a JPEG named Content-Aware A, and 
close the original image, but do not save.

4.	 Open the original image, ContentAware01.jpg again.

5.	 This time, center the person closer to the middle of the 
image. Make a general selection around him using the 
Lasso tool again. 

a.	 Select the Content-Aware Move tool, under the Spot 
Healing Brush too.

b.	 Click on the selection and drag it to the left until it 
is centered. Watch as Photoshop CC analyzes the 
image again and blends the selection into its new 
position.

6.	 Save the image as a JPEG named Content-Aware B.

7.	 Compare Content-Aware A and Content-Aware B to the 
original image.

Reference:
LearnKey’s Photoshop CC Training, Session 2: 

	 Content-Aware: Content-Aware Features; Content-		 		
	 Aware Fill; Patch Tool; Content-Aware Move Tool

Project File: ContentAware01.jpg

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.5 Demonstrate knowledge of retouching and blending images.

4.5d Demonstrate knowledge of how to move or extend a selected object to a new location in the image.
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Session 3
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Session 3 Fill-in-the-Blanks
Instructions: While watching Session 3, fill in the missing words according to the information presented by the instructor. 
[References are found in the brackets.]

Understand Layers
1.	 The 			                layer is unique, in that it cannot have any transparent pixels. [Flattened File]

2.	 The 			               button in the Layers panel is used to link layers together. [Link Layers]

3.	 The 			               feature in the Layers panel menu will merge any visible layers on a document. [Merge 
Layers, Delete, Drag and Drop]

Work with Layer Masks
4.	 Layer masks offer the ultimate in 			                        editing in Photoshop CC. [Layer Masks]

5.	 A mask can be directly modified from the 			                       dialog box. [Properties Panel, Vector Mask]

6.	 A 			            adjustment will allow a user to adjust the exposure of a refined selection in Photoshop 
CC. [Nondestructive Masks, Levels]

Work with Type
7.	 The horizontal and vertical type 			                      tools allow users to type text that will be nondestructive. 

[Type Tools]

8.	 Kerning will adjust the space 			               two characters in a text area. [Kerning, Tracking, Leading, 
Type Layers]

9.	 The anti-alias menu controls how text is going to be 				         in Photoshop CC. [Anti-Aliasing]

10.	 The 			                panel contains a multilingual dictionary for language use in Photoshop CC. 
[Multilingual Dictionaries]

11.	 The blending mode drop-down menu is located in the 			              panel. [How Blending Modes Work]

12.	 The fx button in the Layers panel is used to apply layer 			              to an image. [Apply and Remove 
Layer Effects]

Filters
13.	 The Blur filters are located in the 			                       menu. [Use Blur Filters]

14.	 With the Lens Correction filter, users can make corrections to geometric			                , chromatic 
aberration, and vignette. [Use Seven Lens Correction]

15.	 In order to use the vanishing point filter, users must first establish a 			                        plane. [Vanishing Point 
Filter]

16.	 The keyboard shortcut for duplicating layers in Photoshop CC on a Mac is Cmd+			               . [Smart 
Objects and Smart Filters]

17.	 When a layer is converted to a smart object, the original image is 			                  into the active Photoshop 
CC document. [Smart Objects]

18.	 An easy way to make a smart object is to utilize Place Embedded or Place 			                  from the File 
menu. [Embedded Smart Object]

19.	 When it comes to layer masks, white reveals and 			                   conceals. [Filter Gallery and Layer Masks]
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Shape Tool and Pen Tool
20.	 The Pen tool can be used to create 			                         -based paths on an image document. [Create a Path]

21.	 To activate the heads up color picker tool, hold down the 			                   key on Mac. [Create Shapes, 
Rounded Rectangle]

22.	 There are a lot of tools based on a brush, including the Clone Stamp tool, the 			                         tool, and the 
Blur tool. [Paint Tools, Brush Tools]

23.	 In addition to basic brush tips, there are erodible and 			             brush tip options available in 
Photoshop CC. [Brush Tips]

24.	 Blending modes can be adjusted for brushes and 			                      in Photoshop CC. [Blending Mode for 
Layers, Pencil Tool]

25.	 The job of the History Brush tool is to 			              from another point in the History panel. [History 
Panel and History Brush]

26.	 The Puppet Warp feature is found in the 			                    menu. [Puppet Warp]

27.	 A 			            can be placed anywhere on a computer and executes an action whenever a file is 
dragged over it. [Batch Processing]

28.	 The auto blend feature is useful when combining the 		   	          levels of two similar images. [Auto-
Blend Layers]

29.	 The first thing to consider when publishing an image is to find out if the image is going to web, 			                       	
	                                                        , or print. [Publish Digital Images]

30.	 The 			                 feature in the Generate submenu of the File menu will automatically generate web 
assets for quick web development. [Automatic Asset Generation]
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All About Layers
Description: 
Layers are one of the primary components of working with images inside of Photoshop CC. By using layers you can divide up 
your files to make them much easier to edit. Layers also give you more control over how each object is used within your image. 

For this project, you will demonstrate a basic understanding of using layers in Photoshop CC. 

Steps for Completion:
1.	 Use the worksheet on the next page. 

2.	 Match each concept to its appropriate definition.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Understand Layers: Flattened File; Layered File; Link Layers; Label Elements of Different Types; Merge Layers, Delete, 		
	 Drag and Drop; Flatten Layer

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

3.0 Understanding Adobe Photoshop

3.2 Demonstrate knowledge of layers and masks.

3.2a Identify and label elements of the different types of layers.

3.2d Demonstrate knowledge of how to edit layers.

3.2e Demonstrate knowledge of how to create layer groups and links.

3.2g Identify the differences between a layered file and a flattened file.

3.2h Demonstrate knowledge of how to nest layers.

3.2i Demonstrate knowledge of how to add, delete, hide, show, lock, unlock, merge, duplicate, filter, and rename layers.
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All About Layers Worksheet
Instructions: After watching Session 3, match the concepts to their appropriate definitions according to the information 
presented by the instructor.

1.	 			    Layers nested into a folder.

2.	 			    Layers that can be worked on simultaneously when this feature is applied.

3.	 			    Multiple layers become one single layer and can no longer be edited individually.

4.	 			    Once individual elements are now part of one composite image which is limited in ability to 	
			    be edited.

5.	 			    Contains multiple layers with maximum ability to be edited.

6.	 			    Individual objects with a stacking order.

7.	 			    To view layers by kind, effect, color, or attribute.

8.	 			    A method of dropping a file into a PSD to create a new layer.

9.	 			    Cannot have any transparent pixels.

10.	 			    A file placed in Photoshop CC converts to this format which is useful for nondestructive 	
			    image editing.

11.	 			    To turn off visibility of multiple, consecutive layers.

A.	 Click and drag over the eyeball 
icons

B.	 Smart object

C.	 Linked layers

D.	 Background layer

E.	 Drag and drop

F.	 Merged layers

G.	 Layered file

H.	 Layers

I.	 Grouped layers

J.	 Filter layers

K.	 Flattened file
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Working with Layer Comps
Description: 
Photoshop CC has numerous ways to create layers. The power of layers goes far beyond simple organization and

into the realm of creativity. In this project, students will work with new layers, adjustment layers, layer effects, layer styles, and 
layer comps.

Create at least two layer comps of variations of the man holding the coffee cup using various effects or adjustment layers.  

Steps for Completion:
1.	 Open the WorkingLayers_start.psd file.

2.	 Use any of the various selection tools to select the man with the coffee cup, items in the background, the coffee cup, or 
other items in the photo.

3.	 Cut or copy the selection(s) to their own layers. You may wish to use saving selections, or layer copying techniques to speed 
your workflow.

4.	 Use adjustment layers, layer styles, or layer effects (or any combination of the three) to create a unique presentation of the 
photo.

5.	 Repeat steps 2‐4 to create another version of the photo.

6.	 Save at least two different versions of the photo as layer comps.

7.	 Present the layer comps to an instructor or peer.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Understand Layers: Flattened File; Layered File; Link Layers; Label Elements of Different Types; Merge Layers, Delete, 		
	 Drag and Drop; Flatten Layer

Project File: WorkingLayers_start.psd, WorkingLayers_end.psd

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

3.0 Understanding Adobe Photoshop

3.1 Identify elements of the Photoshop user interface and demonstrate knowledge of their functions. 

3.1a Identify and label elements of the Photoshop interface.

3.1e Demonstrate knowledge of the functions of the Properties panel.

3.1f Demonstrate knowledge of non-destructive editing.

3.2 Demonstrate knowledge of layers and masks.

3.2a Identify and label elements of the different types of layers. 

3.2d Demonstrate knowledge of how to edit layers.

3.2f Demonstrate knowledge of how to flatten layers. 

3.2h Demonstrate knowledge of how to nest layers.

3.2i Demonstrate knowledge of how to add, delete, hide, show, lock, unlock, merge, duplicate, filter, and rename layers.
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Working with Layer Masks
Description: 
Photoshop CC allows you to build artwork in layers. Layer masking allows you to hide or use as much of any one layer as you 
like.

For this project, you will use PHOTO3.JPG and create a layer mask around the boy so that you can make changes to the boy and 
the background separately. You will use the Refine Mask dialog box to make changes to the image. Feather the edges to make 
a nice divide. Change the color of the background by overlaying. Then create a Vector mask and a shape with drop shadow to 
customize the image.  

Steps for Completion:
1.	 Open PHOTO3.JPG in Photoshop CC.

2.	 Create a duplicate layer.

3.	 Use the Quick Selection tool to select the boy.

4.	 Create a new layer mask.

5.	 Use the Refine Mask to feather the edges around the boy.

6.	 Place a solid color on the background. 

7.	 Overlay the background with the solid color.

8.	 Change the Background layer to Layer 0.

9.	 Select all layers and create a new layer group.

10.	 Create a Vector mask to hide all.

11.	 Use the Custom Shape to insert a shape to show the boy’s face.

12.	 Apply a drop shadow.

13.	 Add a white background. 

14.	 Save your changes to the image.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Work with Layer Masks: Layer Masks; Properties Panel, Vector 
Mask; Nondestructive Masks, Levels

Project File: PHOTO3.JPG

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

3.0 Understanding Adobe Photoshop

3.2 Demonstrate knowledge of layers and masks.

3.2b Demonstrate knowledge of masks and modes.

3.2c Demonstrate knowledge of how to create masks.

3.2d. Demonstrate knowledge of how to edit layers.

3.2e Demonstrate knowledge of how to create layer groups and links.

3.2i Demonstrate knowledge of how to add, delete, hide, show, lock, unlock, merge, duplicate, filter, and rename layers.
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Typography Basics in Photoshop CC
Description: 
Magazine publishers, editors, and creation directors recognize the significance of a cover image as both a newsstand 
persuasion for an impulse buy and as a brand. Consumer magazine newsstand sales are determined by what is shown on 
the cover, a fact that can mean the difference between a magazine’s success or failure over time. The cover image and design 
support the brand, an essential recognition aspect because the average reader spends only three to five seconds looking at a 
magazine cover prior to deciding whether to buy that issue.  Magazine covers not only offer information about what’s inside a 
particular issue, they also provide significant cultural cues about trends.  

In this project, you will design a magazine cover, paying particular attention to aspects such as interruptions, readability, and 
alignment. You will then implement an appropriate font size to different aspects of the cover, such as the title, story title lines, 
issue dates (etc). You will also demonstrate your knowledge of text placement for a variety of different situations. Develop a 
theme for the magazine (about yourself, sports, music, food, hobbies, etc.).  

Steps for Completion:
1.	 Open a new canvas.

2.	 Develop a theme for a magazine. 

3.	 Design a magazine cover and pay attention to interruptions, readability, and alignment.

4.	 Input appropriate font size. (Note: use a maximum of three different fonts and three different font sizes).

5.	 Fonts should be applied to a title, story title line, issue dates.

6.	 Ensure the colors are print safe.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Work with Type: Type Tools; Character Panel, Options Bar; Kerning, Tracking, Leading, Type Layers; Layer Styles to 		
	 Type; Anti-Aliasing; Fill and Opacity; Multilingual Dictionaries; Blending Mode; How Blending Modes Work; Blending 		
	 Mode Options; Apply and Remove Layer Effects

Project File: N/A

Difficulty: Advanced 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.3 Demonstrate knowledge of typography.

2.3a Demonstrate knowledge of how background image can affect text.

2.3c Identify an appropriate placement of text for a variety of situations.

4.0 Manipulating Images by Using Adobe Photoshop

4.7 Demonstrate knowledge of type.

4.7a Demonstrate knowledge of the functionality of each type panel option.

4.7b Demonstrate knowledge of functionality of type tools.

4.7c Demonstrate knowledge of the uses type layers.

4.7d Demonstrate knowledge of how to edit type.
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Using Type
Description: 
Photoshop CC offers multiple options to edit and manipulate the appearance of type in an image. 

For this project, you will demonstrate knowledge of various options regarding adding type (also called text) to an image.  

Steps for Completion:
1.	 Open an image file that features multiple objects.

2.	 Add horizontal and vertical text to various objects, as both characters and paragraphs. 

3.	 Edit the text to change the wording.

4.	 Experiment with various text options such as kerning, justification, alignment, and anti-aliasing.

5.	 Use the Horizontal Type Mask tool and/or Vertical Type Mask tool in order to create a selection in the shape of text and to 
show the background.

Reference:
LearnKey’s Photoshop CC Training, 

Session 3: 

Work with Type: Type Tools; Character Panel, Options Bar; Kerning, Tracking, Leading, Type Layers; Layer Styles to Type; Anti-
Aliasing; Fill and Opacity; Multilingual Dictionaries; Blending Mode; How Blending Modes Work; Blending Mode Options; 
Apply and Remove Layer Effects

Project File: N/A

Difficulty: Advanced 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.7 Demonstrate knowledge of type.

4.7a Demonstrate knowledge of the functionality of each type panel option.

4.7c Demonstrate knowledge of the uses type layers.

4.7d Demonstrate knowledge of how to edit type.
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Working with Type
Description: 
Text in Photoshop CC is an important element to your artwork. Knowing how to utilize text will make you a versatile designer. 
In this project, you’ll demonstrate your knowledge of adding text to an image, how to edit text, and how to add effects to text.  

Steps for Completion:
1.	 Open the Type.psd Course Support file and select the Horizontal Type tool.

2.	 Create a text box and type “Photoshop CC.”

3.	 Change the font of the text to Verdana.

4.	 Change the font color to white and align the text in the center of the text box.

5.	 Add a drop shadow effect to the text.

6.	 Save your progress.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Work with Type: Type Tools; Character Panel, Options Bar; Kerning, Tracking, Leading, Type Layers; Layer Styles to 		
	 Type; Anti-Aliasing; Fill and Opacity; Multilingual Dictionaries; Blending Mode; How Blending Modes Work; Blending 		
	 Mode Options; Apply and Remove Layer Effects

Project File: Type.psd

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.3 Demonstrate knowledge of typography.

2.3a Demonstrate knowledge of how background image can affect text.

2.3b Identify an appropriate font size, type, and color for a variety of situations.

2.3c Identify an appropriate placement of text for a variety of situations.

4.0 Manipulating Images Using Adobe Photoshop

4.7 Demonstrate knowledge of type. 

4.7a Demonstrate knowledge of the functionality of each type panel option.

4.7b Demonstrate knowledge of functionality of type tools.

4.7c Demonstrate knowledge of the uses type layers.	

4.7d Demonstrate knowledge of how to edit type.

4.8 Demonstrate knowledge of filters.

4.8c Demonstrate knowledge of how to apply layer styles to type.
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Using Filters
Description: 
The Filter Gallery in Photoshop CC features a list of available filters, filter settings, as well as a preview window allowing users to 
test filter settings on an image before deciding which settings to apply.  

For this project, you will demonstrate knowledge of a wide variety of options available in the Filter Gallery. You will apply 
different filters from each of the folder options and save each image.  You will end with eight filtered images. There are several 
options in the Filter Gallery dialog box which allow you to make additional changes to the filter. Be sure to use the Brush Size, 
Definition, and Smoothness settings while implementing these filters. Then use the Filter menu to apply an Iris Blur filter. 
Change the image to match the provided screenshot.  

Steps for Completion:
1.	 Open PHOTO2.JPG in Photoshop CC.

2.	 Open the Filter Gallery.

3.	 Open the Artistic folder.

4.	 Select the Sponge filter option.

5.	 Change the Definition to 6.

6.	 Change the Smoothness to 1.

7.	 Save the image.

8.	 Apply filters using Brush Stroke, Distort, Sketch, Stylize, and Texture.

9.	 Save each image.

10.	 Click the Filter menu.

11.	 Select Iris Blur.

12.	 Make changes using the mouse and the Blur Tools panel.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Filters: Use Filters, Sharpen Tools, Unsharp Mask; Use Blur Filters; 
Use Filter Gallery; Use Seven Lens Correction; Additive Grain; Vanishing 
Point Filter; Smart Objects and Smart Filters; Free Transform; Smart 
Objects; Embedded Smart Object; Smart Filters; Filter Gallery and Layer Masks

Project File: PHOTO2.JPG

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.8 Demonstrate knowledge of filters.

4.8a Demonstrate knowledge of how to use the Filter Gallery.

4.8d Demonstrate knowledge of using smart filters.

4.8e Identify the appropriate filter to use for a variety of situations.

4.8h Demonstrate knowledge of editing images using Blur filters.
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More Filters
Description: 
Filters are one of Photoshop CC’s most powerful tools. They allow you to alter an image in artistic and useful ways. In this 
project you will demonstrate your knowledge of blur and sharpen filters. You will also utilize some of the filters from the Filter 
Gallery.  

Steps for Completion:
1.	 Open the Shoreline.psd Course Support file and add an Unsharp Mask filter.

2.	 Sharpen the image by altering the Amount, Radius, and Threshold.

3.	 Select the Field Blur filter and place three widgets on the image.

4.	 Click and drag the widgets to different parts of the image and alter the filter strength. 

5.	 Open the Filter Gallery and add a Film Grain filter from the Artistic section.

6.	 Click the New effect layer button and add a Mosaic Tiles filter from the Texture section.

7.	 Save your progress.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Filters: Use Filters, Sharpen Tools, Unsharp Mask; Use Blur Filters; Use Filter Gallery; Use Seven Lens Correction; 		
	 Additive Grain; Vanishing Point Filter; Smart Objects and Smart Filters; Free Transform; Smart Objects; Embedded 		
	 Smart Object; Smart Filters; Filter Gallery and Layer Masks

Project File: Shoreline.psd

Difficulty: Advanced 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images Using Adobe Photoshop

4.5 Demonstrate knowledge of retouching and blending images.

4.5e Demonstrate knowledge of how to sharpen an image.

4.8 Demonstrate knowledge of filters.

4.8a Demonstrate knowledge of how to use the Filter Gallery.

4.8e Identify the appropriate filter to use for a variety of situations.
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Smart Objects
Description: 
Adding filters to layers in Photoshop CC is one way to add artistic or stylistic elements to your images. However, filters

in Photoshop CC are referred to as “destructive” editing, meaning that the original layer is lost in favor of the new filtered layer. 
This can be problematic if you or your client decides that there needs to be a change that requires the original image. Smart 
Objects eliminate this problem. 

For this project, choose one layer and create duplicate layers from it. Then convert one to a Smart Object; duplicate the Smart 
Object. Apply an artistic filter of your choice to both the copied layer and one of the Smart Object layers. Then edit the Smart 
Object to show that it affects both the filtered and non‐filtered Smart Object layers. Finally, change the filter on the Smart 
Object and attempt to change the filter on the non‐Smart Object duplicated layer.  

Steps for Completion:
1.	 Open the SmartObjects_start.psd file.

2.	 Duplicate the “Sample” layer twice.

3.	 Convert one of the duplicated layers to a Smart Object.

4.	 Duplicate this layer.

5.	 Apply an artistic filter to one of the Smart Object layers and the duplicated Sample layer.

6.	 Edit the Smart Object to include text.

7.	 Change the filter on the Smart Object from one artistic filter to another. (Note: the end file has both of the filters on the 
Smart Object, but only one is shown—again, to illustrate the value of Smart Objects)

8.	 Attempt to do the same on the duplicated Sample layer.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Filters: Use Filters, Sharpen Tools, Unsharp Mask; Use Blur Filters; Use Filter Gallery; Use Seven Lens Correction; 		
	 Additive Grain; Vanishing Point Filter; Smart Objects and Smart Filters; Free Transform; Smart Objects; Embedded 		
	 Smart Object; Smart Filters; Filter Gallery and Layer Masks

Project File: SmartObjects_start.psd, SmartObjects_end.psd

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

3.0 Understanding Adobe Photoshop

3.1 Identify elements of the Photoshop user interface and demonstrate knowledge of their functions.

3.1e Demonstrate knowledge of the functions of the Properties panel.

3.2 Demonstrate knowledge of layers and masks.

3.2a Identify and label elements of the different types of layers.

3.4 Demonstrate knowledge of producing and reusing images.

3.4b Identify techniques used to produce reusable images.

4.0 Manipulating Images by Using Adobe Photoshop

4.3 Transform Images.

4.3e Demonstrate knowledge of how to reposition or warp image elements.
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Keeping Things in Perspective
Description: 
Photoshop CC provides powerful filters that you can use to add aesthetics to the images you are working on. One in specific is 
the Vanishing Point filter.

For this project, you will demonstrate basic knowledge of the Filter Gallery, the Vanishing Point filter, and the Perspective Crop 
and Clone Stamp tools.   

Steps for Completion:
1.	 Use the worksheet on the next page.

2.	 Complete the short answer questions.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Filters: Use Filters, Sharpen Tools, Unsharp Mask; Use Blur Filters; Use Filter Gallery; Use Seven Lens Correction; 		
	 Additive Grain; Vanishing Point Filter; Smart Objects and Smart Filters; Free Transform; Smart Objects; Embedded 		
	 Smart Object; Smart Filters; Filter Gallery and Layer Masks

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.8 Demonstrate knowledge of filters.

4.8a Demonstrate knowledge of how to use the Filter Gallery.

4.8g Demonstrate knowledge of editing images using the vanishing point filter.
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Keeping Things in Perspective Worksheet
Instructions: After watching Session 3, complete the short answer questions according to the information presented by the 
instructor.

1.	 Where is the Filter Gallery located in Photoshop CC?

2.	 In the Filter Gallery, only one filter may be applied at one time to an image. True or False? Please Explain.

3.	 Discuss the Vanishing Point filter, the Perspective Clone Stamp tool, and the Perspective Crop tool and how they work 
together in Photoshop CC. Give an example of when you would utilize this technique.



71 | Session 3 Photoshop CC Project Workbook

Using the Pen Tool
Description: 
Photoshop CC provides multiple tools that can be used to draw vector-based shapes. These shapes are useful when you need 
to add elements to your designs. There are a few tools great for drawing shapes, such as the Rectangle tool, Rounded Rectangle 
tool, Ellipse tool, Polygon tool, Line tool, and Custom Shape tool. In addition, the Pen tool is the most powerful tool for drawing 
shapes from scratch. The more you practice using the Pen tool, the better you will get. 

For this project, you will practice the silhouette technique by creating a path around an object in a photo to isolate it from the 
background.     

Steps for Completion:
1.	 Create a new document in Photoshop CC that is 10 x 10 inches, 300 pixels per inch, and RGB Color.

2.	 Place the Lock.jpg image file in your new document.

3.	 Use the Pen tool to create a selection of the lock. (Note: the end goal is to have a silhouette of the lock without the key or 
background.)

4.	 With the Pen tool selected, change the Option Bar settings from Shape to Path. 

5.	 Zoom in to 100% and begin the click-and-drag technique with the Pen tool to create a path around the lock that matches 
the curvature perfectly. 

6.	 Pretend that the key is not there so as only to silhouette the lock.

7.	 Tips: Use the Alt key to shorten directional handles when necessary. Use the Ctrl key to activate the Direct Selection tool to 
edit or move anchor points along the way. When completing the path, hold down the Alt key as you connect to the initial 
anchor point to click and drag the last curve into place.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Draw Using Shape Tool and Pen Tool; Create a Path; Photoshop Path

Project File: Lock.jpg

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.6 Demonstrate knowledge of drawing and painting.

4.6a Demonstrate knowledge of drawing by creating vector layers and paths.

4.6b Demonstrate knowledge of how to edit a path.
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Drawing
Description: 
In this project, you will demonstrate knowledge of a variety of techniques used in drawing, including various tools and options. 
This project can look as pretty or as disorganized as you want, but most of all be creative in what you are doing.     

Steps for Completion:
1.	 Open a new document with the default Photoshop CC 

size and a white background. 

2.	 Change the width and height to create a square.

3.	 Change resolution to 300 pixels per inch.

4.	 Use the Rectangle tool to create a rectangle and use 
the Shift key to create a square.

5.	 Change the Rectangle tool to the Ellipse tool.

6.	 Draw a circle using the Shift key.

7.	 Change to the Polygon tool. 

8.	 Draw a five-sided polygon.

9.	 Change the number of sides and draw another 
polygon.

10.	 Change to the Custom Shape tool.

11.	 Select and create a custom shape.

12.	 Use the Pencil tool to add free form shapes.

13.	 Use the Pen tool to create a unique shape.

14.	 Save the canvas to your Photoshop CC folder.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Draw Using Shape Tool and Pen Tool; Create a Path; Photoshop Path; Create Shapes, 		
	 Rounded Rectangle; Custom Shapes, Preset Shapes; Blending Mode for Layers, Pencil Tool

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.6 Demonstrate knowledge of drawing and painting.

4.6a Demonstrate knowledge of drawing and creating vector layers and paths.

4.6c Identify tools that are used for painting.

4.6d Identify tools that are used for drawing, or creating shapes.

4.6e Identify the purpose of an option from the Brushes panel.

4.6f Demonstrate knowledge of color blending.
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Painting
Description: 
Using the Brush tool comes with various options, like colors, brush sizes, and brush shapes. In this project you will demonstrate 
knowledge of a variety of techniques used in painting, including various tools and options.  

Steps for Completion:
1.	 Open a new canvas.

2.	 Use the Brush tool and the different brush types to create a picture.

3.	 Use the on-screen color picker to select different brush colors. 

4.	 Use the Mixer Brush to define multiple colors on a single brush tip and then mix and blend them into the other colors on 
the canvas.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Paint Tools, Brush Tools; Brush Tips; Brush Presets; Color Blending Tools; Blending Mode for 	
	 Layers, Pencil Tool; Mixer Brush; History Panel and History Brush; Puppet Warp

Project File: N/A

Difficulty: Advanced 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.6 Demonstrate knowledge of drawing and painting.

4.6a Demonstrate knowledge of drawing and creating vector layers and paths.

4.6c Identify tools that are used for painting.

4.6d Identify tools that are used for drawing, or creating shapes.

4.6e Identify the purpose of an option from the Brushes panel.

4.6f Demonstrate knowledge of color blending.
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Paint and Brush Tools
Description: 
Paint and brush tools are some of the most basic tools you’ll ever use in Photoshop CC. In this project you will demonstrate 
your knowledge of various paint tools and basic blending modes. 

Steps for Completion:
1.	 Open the Black Eyed Susan.psd Course Support file, select the eraser tool and make a stroke on the image.

2.	 Select the brush tool, select an erodible brush tip and make a stroke on the image.

3.	 Desaturate the image from the Image menu and change the blending mode to Screen.

4.	 Decrease the size of your brush tool and paint one of the larger flower petals a yellow color.

5.	 Change the blending mode to Overlay and paint another petal. 

6.	 Save your progress.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Paint Tools, Brush Tools; Brush Tips; Brush Presets; Color Blending Tools; Blending Mode for 	
	 Layers, Pencil Tool; Mixer Brush; History Panel and History Brush; Puppet Warp

Project File: Black Eyed Susan.psd

Difficulty: Advanced 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.6 Demonstrate knowledge of drawing and painting.

4.6c Identify tools that are used for painting.

4.6e Identify the purpose of an option from the Brushes panel.

4.6f Demonstrate knowledge of color blending.
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Custom Brushes
Description: 
Digital painting, whether from scratch or used as an enhancement to an existing image, is another one of Photoshop CC’s 
powerful tools. 

For this project, you will create a new file and experiment with the various brush types, brush sets, and brush modes. You will 
then create a custom brush.  

Steps for Completion:
1.	 Open a new document that is at least 500 x 400 pixels, 72 dpi, with a white background. (File > New)

2.	 Spend some time experimenting with the various brush capabilities. Open the other brush sets and use them to get a feel 
for what digital painting in Photoshop CC has to offer.

3.	 Be sure to try the brush modes on a variety of brush styles; you might be surprised at the differences each mode brings out.

4.	 Create a new custom brush and then try it out in your document.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Paint Tools, Brush Tools; Brush Tips; Brush Presets; Color Blending Tools; Blending Mode for 	
	 Layers, Pencil Tool; Mixer Brush; History Panel and History Brush; Puppet Warp

Project File: N/A

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.6 Demonstrate knowledge of drawing and painting.

4.6a Demonstrate knowledge of drawing and creating vector layers and paths.

4.6c Identify tools that are used for painting.

4.6d Identify tools that are used for drawing, or creating shapes.

4.6e Identify the purpose of an option from the Brushes panel.

4.6f Demonstrate knowledge of color blending.
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Puppet Warp
Description: 
Photoshop CC allows users to change parts of an image by using the Puppet Warp tool. This tool can move objects or parts of an 
image to different areas while still being attached to other parts of the image.

In this project, you will use the Puppet Warp tool by opening Babygirl.jpg and rasterizing the image. Using the Lasso tool, select 
the baby’s arm. Then create a new layer. Select Puppet Warp from the Edit menu. Place four pin points: one on the hand, two 
near the elbow, and one on the shoulder. Use the pin on the hand to move the hand as desired. Save the image.  

Steps for Completion:
1.	 Open Babygirl.jpg in Photoshop CC.

2.	 Rasterize the image.

3.	 Use the Lasso tool to select the baby’s arm.

4.	 Create a new layer with the selection on it with the shortcut Ctrt/Cmd+J.

5.	 In the selected area, use the Puppet Warp tool.

6.	 Place pin points: one on the hand, two near the elbow, and one on the shoulder.

7.	 Use the pin on the hand to move the hand.

8.	 Save changes to the image.

Reference:
LearnKey’s Photoshop CC Training, 

Session 3: 

Shape Tool and Pen Tool: Paint Tools, Brush Tools; Brush Tips; Brush Presets; Color Blending Tools; Blending Mode for Layers, 
Pencil Tool; Mixer Brush; History Panel and History Brush; Puppet Warp

Project File: Babygirl.jpg

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.3 Transform images.

4.3e Demonstrate knowledge of how to reposition or warp image elements.
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Photoshop CC Actions
Description: 
Whether you’re working in a production environment, or just trying to save as much time as possible, Photoshop CC provides 
some ways that you can automate things so you’re not spending time doing it manually. For example, you have the ability to 
create actions, which are ways you can record things you are doing and save it to replay the process on other files. The Actions 
panel has many prebuilt actions, or you can create your own. In addition, you may also create a droplet, which is another way to 
apply actions.

For this project, you will record a series of actions in Photoshop CC that can be played again in other files.      

Steps for Completion:
1.	 Open an image in Photoshop CC. You can use one of your own, or use one from a previous project.

2.	 Create an action that converts the image to black and white and applies a vignette. 

a.	 Open the Actions panel from the Window menu.

b.	 Collapse the Default Actions folder to make more room.

c.	 Create a new folder named Sample Actions. 

d.	 Click the new actions button and name your action BW Vignette.

e.	 Click the Record button.

f.	 In the Adjustments panel, click the Black and White adjustment to apply it to your image.

g.	 Make any changes to the adjustment layer settings that you want.

h.	 In the Layers panel, click Flatten Image from the pop-out menu.

i.	 From the Filter menu, click the Lens Correction option.

j.	 Under Custom, adjust the Vignette slider bar to create a dark vignette around the edges of the photo. Click the OK 
button to close out of the dialog box.

k.	 Back in the Actions panel, click the Stop button to finish recording the action.

3.	 Now that you have recorded your BW Vignette action, revert to the original photo from the File menu, Revert.

4.	 From here, select the BW Vignette action in the Actions panel, and click the Play button. Watch as those steps are applied to 
your photo automatically.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Batch Processing

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

4.0 Manipulating Images by Using Adobe Photoshop

4.1 Demonstrate knowledge of working with selections.

4.1j Demonstrate knowledge of batch-processing techniques.
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Merge to HDR
Description: 
The Merge to HDR feature in Photoshop CC is a great way to composite images. Compositing images is taking elements 
from three or more images and creating one single image. For example, if you have three images that all have different parts 
underexposed and overexposed as well as parts in detail, the composite image will take the details from all three and create a 
new image.

For this project, you will write a brief paper explaining the Merge to HDR feature.   

Steps for Completion:
1.	 Use the worksheet on the next page. 

2.	 Write a brief paper explaining the Merge to HDR process.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Batch Processing; Auto-Align Layers; Auto-Blend Layers; 32-Bit Merge to HDR; Publish 		
	 Digital Images

Project File: N/A

Difficulty: Intermediate 

Required Materials: Photoshop CC

Objectives:

2.0 Identifying Design Elements When Preparing Images

2.4 Demonstrate knowledge of color correction using Photoshop.

2.4h Demonstrate knowledge of 32-bit HDR imaging.

4.0 Manipulating Images by Using Adobe Photoshop

4.1 Demonstrate knowledge of working with selections.

4.1i Demonstrate knowledge of how to composite images.

4.1j Demonstrate knowledge of batch-processing techniques.
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Merge to HDR Worksheet
Instructions: After watching Session 3, Complete the short essay according to the information presented by the instructor.

1.	 When it comes to compositing images, Merge to HDR is a powerful feature. Write a short essay discussing how this 
feature works.
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Web Gallery
Description: 
Adobe Bridge can be used to create a web gallery and a PDF file of selected images. The PDF file allows users to show others the 
image. The web gallery is used to have images ready to be used in a website. 

  
For this project, you will use the Adobe Bridge to create a web gallery and a PDF file of a collection. This collection may be 
useful in future Adobe courses. You will need a server to upload images. If no server is available, save your work to a folder or 
a cloud server. Use Adobe Bridge to create a New Collection. This collection should have a minimum of five images. Using the 
Output option, select the images and then create a PDF and a web gallery. To maintain consistency and to easily find your work, 
name files something that you will be able to find quickly.       

Steps for Completion:
1.	 In Photoshop CC, navigate to Browse in Bridge.

2.	 Select Collections.

3.	 Create a New Collection.

4.	 Rename the collection.

5.	 Place desired images in the collection.

6.	 Select Output.

7.	 Click the PDF button.

8.	 Select images.

9.	 Modify the document to show desired information.

10.	 Save and Preview PDF.

11.	 Click the Web Gallery button.

12.	 Select images.

13.	 Choose a template.

14.	 Preview in a browser.

15.	 Insert a Site Title.

16.	 Insert contact information.

17.	 Create a Header.

18.	 Insert a Gallery Name.

19.	 Insert server information and username and password.

20.	 Click the Upload button.

Reference:
LearnKey’s Photoshop CC Training, Session 3: 

	 Shape Tool and Pen Tool: Publish Digital Images; Publish to Web; Publish for use in Videos; Web Photo Gallery; 		
	 Automatic Asset Generation; Real Time Image Generation

Project File: N/A

Difficulty: Beginner 

Required Materials: Photoshop CC

Objectives:

5.0 Publishing Digital Images by Using Adobe Photoshop

5.1 Demonstrate knowledge of preparing images for web, print, and video.

5.1a Demonstrate knowledge of the elements of web images that need to be checked or confirmed prior to publishing.to the web.

5.1b Demonstrate knowledge of creating a Web Photo Gallery.

5.1c Demonstrate knowledge of the elements of images that need to be checked or confirmed prior to print publishing.
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Master Project
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Photoshop CC Master Project
Description: 
Now that you have completed all of LearnKey’s Photoshop CC training, it is time to apply all of that information into one major 
project. This project is divided into three parts. Throughout these parts you will choose a topic, create a project plan which 
includes using your images on a web page, for print, and create a cover for your topic. You will use the Adobe Bridge to organize 
your images and create metadata for web use.

For Part 1, you will choose your topic, create your project plan, and using a digital camera take 25 images based on your topic. 
Open your images in Adobe Bridge. Separate your images into two collections and create metadata for each image. In Part 
2, you will take one group from Adobe Bridge and begin to make changes to them so the images can be used on the web. To 
conclude, in Part 3, you will make changes to the second group from Adobe Bridge and prepare each image to be printed for 
advertisement for your website. Finally, you will create a cover for your portfolio. After you have created the cover you will put 
together the portfolio with the cover as an introduction. Then select your 10 favorite images to use for your website and your 
print projects. These you will print off as part of your portfolio.

Part 1
Description: 
In this section you will begin by choosing a topic. When you decide on the topic you will need to determine an audience and 
the purpose you want to accomplish as well as set goals for the project. Take 25 pictures using a digital camera. Then use Adobe 
Bridge to organize your images.

Steps for Completion:
1.	 Choose a topic.

2.	 Create a project plan by determining an audience and purpose.

3.	 Using a digital camera, take 25 pictures.

4.	 Open images in Adobe Bridge.

5.	 Create two new collections: one group specifically for web use and one group specifically for print use.

6.	 In each group add metadata to each image.

7.	 Include a copyright statement and a specific name for each.

8.	 Include your name in the metadata.

(continued on next page)
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Part 2
Description: 
From one of your groups import each image into Photoshop CC. You will need to use the full gamut of the tools and galleries 
provided to make modifications to each image. These images will need to be ready for use on a website.

Steps for Completion: 
1.	 Customize your workspace by moving and adding panels.

2.	 Insert the Navigation and Histogram panels.

3.	 Colorize the menus that you use the most often. 

4.	 Create a new set using the Keyboard Shortcuts and Menus dialog box.

5.	 Add a customized keyboard shortcut to Place.

6.	 Use images from the group you created in Adobe Bridge for web use.

7.	 Add auto tone to half of the group.

8.	 Using the appropriate tools, touch up each image. This would include fixing the image using the Red Eye tool, Clone Stamp 
tool, Spot Healing Brush, Healing Brush, Patch tool, or the Content-Aware Move.

9.	 Combine two or three images into one image using overlay and the Snap To options and guidelines. Draw an object on the 
image. Then make the object be able to contain type. Use the Type tool to place a title or description of each image. 

10.	 Using three images pick the focus of the image. Separate the focus from the background. Change the background color. 
Create a layer group. Overlay an object to cut out everything but what the object covers. Create a drop shadow.

11.	 Using two images and the Puppet Warp tool move a portion of the images to a new a position. 

12.	 Use the filter option to add various filters to three different images.

13.	 Open four images in Camera raw and use the histogram panel to make changes to images that may be too bright, make 
shadows more defined, or make other color adjustments.

14.	 Create a blank white canvas.

15.	 Use the Pen tool and the Brush tool to draw a picture which relates to you. This will be the back page of your portfolio.

16.	 Merge three images using the HDR feature from Adobe Bridge.

17.	 Create and save a new action that changes an image to black and white and applies a vignette. 

(continued on next page)
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Part 3
Description: 
For this final section, you will save your chosen images so that they can be printed and placed on the web. Print out your 
10 favorite images to be used in a portfolio. Have the images range from 5 x 6 to 8.5 x 11. Export another five of your favorite 
images to Zoomify to be viewed on the web. Create a cover for your portfolio. The cover should include a title, with some of your 
favorite images names on them with the page number, similar to a magazine cover.

Steps for Completion:
1.	 Save images in RGB or CMYK.

2.	 Print edited images and print the original images.

3.	 Print the 10 images that you designed specifically for print. Have varying print sizes, but make sure that the images do not 
exceed the size of 8.5 x 11.

4.	 Print the 10 images that you designed for web use as they would have appeared on the website.

5.	 Export five images to Zoomify.

6.	 Create a cover page for your portfolio. This should look similar to a magazine cover with a title, a sub menu with a few 
names of images and their page number.

7.	 Make sure that the portfolio contains the links to Zoomify so that the images can be viewed.

8.	 Put together the portfolio and have each printed photo with a side-by-side of the original to show changes to the image. 

Required Materials: Photoshop CC
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Appendix



Photoshop CC Lesson Plans

Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Session 1 Pre-

Assessment

Lesson 2 Intro to 
Photoshop CC

Project Requirements
Project Specifications

1.0 Setting Project Requirements
1.1 Identify the purpose, audience, and audience 
needs for preparing images. 

1.1a Identify information that determines 
purpose, audience, and audience needs for 
image production.

1.2 Demonstrate knowledge of standard copyright 
rules for images and image use. 

1.2a Use copyright terms correctly, such as 
copyrighted, fair use doctrine, intellectual 
property, and derivative works.
1.2b Identify when permission must be 
obtained to use copyrighted material. 
1.2c Identify methods used to indicate that 
images are copyrighted. 

1.3 Demonstrate knowledge of project 
management tasks and responsibilities. 

1.3a Identify items that might appear on a 
project plan. 
1.3b Identify phases that might appear on a 
project plan.
1.3c Identify deliverables that might be 
produced during the project.
1.3d Identify common problems and issues in 
project management.

1.4 Communicate with others (such as peers and 
clients) about design plans. 

 1.4a Demonstrate knowledge of techniques 
for gathering feedback on design plans from 
others (such as peers and clients). 

Watch Session 1: Intro 
to Photoshop CC [5 
minutes]

Fill-in-the-Blanks 
Session 1: Question 1

Session 1 Project 1: 
Create a Project Plan

Session 1 Project 2: 
Providing Feedback 

Session 1 [Approximately 8 hours total]

Each lesson plan is approximately 30 minutes and includes video training, fill-in-the-blanks, labs, projects, tests, as well as the course support files to follow along with the expert. There is also a note 
section for customizable lesson plans and extra notes. By adhering to the lesson plan, it will take approximately four weeks to complete the course. Approximately 24 hours of time training with an 
additional 6-12 hours if the Master Level lesson plans are also completed.



Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Session 1 Pre-

Assessment

Lesson 2 Intro to 
Photoshop CC

Project Requirements
Project Specifications

1.0 Setting Project Requirements
1.1 Identify the purpose, audience, and audience 
needs for preparing images. 

1.1a Identify information that determines 
purpose, audience, and audience needs for 
image production.

1.2 Demonstrate knowledge of standard copyright 
rules for images and image use. 

1.2a Use copyright terms correctly, such as 
copyrighted, fair use doctrine, intellectual 
property, and derivative works.
1.2b Identify when permission must be 
obtained to use copyrighted material. 
1.2c Identify methods used to indicate that 
images are copyrighted. 

1.3 Demonstrate knowledge of project 
management tasks and responsibilities. 

1.3a Identify items that might appear on a 
project plan. 
1.3b Identify phases that might appear on a 
project plan.
1.3c Identify deliverables that might be 
produced during the project.
1.3d Identify common problems and issues in 
project management.

1.4 Communicate with others (such as peers and 
clients) about design plans. 

 1.4a Demonstrate knowledge of techniques 
for gathering feedback on design plans from 
others (such as peers and clients). 

Watch Session 1: Intro 
to Photoshop CC [5 
minutes]

Fill-in-the-Blanks 
Session 1: Question 1

Session 1 Project 1: 
Create a Project Plan

Session 1 Project 2: 
Providing Feedback 

Lesson Topic Subtopic Objectives Activity Notes
Lesson 3 The Capture Import Photos

Metadata
Functions of a Camera
Scanning an Image
Scanned Images
Photoshop Workspace
Configure Image 

Display
Panels
Customize Workspace
Save Custom 

Workspace
Customize Keyboard
Customize Menus
Deleting Presets and 

Favorites

2.0 Identifying Design Elements When Preparing 
Images

2.5 Demonstrate knowledge of image-generating 
devices, their resulting image types, and how to 
access resulting images in Photoshop. 

2.5a Demonstrate knowledge of digital 
photography/cameras.
2.5b Demonstrate knowledge of scanning.
2.5d Identify the differences between scanned 
images, digital camera images, and camera 
raw. 

2.6 Understand key terminology of digital images.
2.6a Demonstrate knowledge of key 
terminology of digital images.

3.0 Understanding Adobe Photoshop 
3.1 Identify elements of the Photoshop user 
interface and demonstrate knowledge of their 
functions. 

3.1a Identify and label elements of the 
Photoshop interface.
3.1b Demonstrate knowledge of how to 
organize and customize the workspace.
3.1c Demonstrate knowledge of the functions 
of tools on the Tools panel.  
3.1d Demonstrate knowledge of the functions 
of various panels.

3.3 Demonstrate knowledge of importing, 
exporting, organizing, and saving.

3.3b Demonstrate knowledge of how to open 
scanned images, digital camera images, 
camera raw images, and video files in 
Photoshop. 

Watch Session 1: The 
Capture [24 minutes]

Fill-in-the-Blanks 
Session 1: Questions 
2-10

Lesson 4 The Capture See Lesson 3 See Lesson 3 Session 1 Project 
3: Customize the 
Workspace

Session 1 Project 4: 
Customize Menus

Lesson 5 The Capture See Lession 3 See Lesson 3 Session 1 Project 5: The 
Scanned Image

Session 1 Lab 1: 
Importing Images

Session 1 Lab 2: Using 
the Camera Raw Dialog 
Box



Lesson Topic Subtopic Objectives Activity Notes
Lesson 6 The Capture See Lesson 3 See Lesson 3 Session 1 Lab 3: 

Scanning an Image

Session 1 Lab 4: 
Configure the Image 
Display

Session 1 Lab 5: Adding 
Panels

Session 1 Lab 6: The 
Navigator Panel

Session 1 Lab 7: Save the 
Workspace

Lesson 7 Open Files in 
Photoshop CC

Open Files
DNG Files
Using the Mini Bridge

2.0 Identifying Design Elements When Preparing 
Images

2.5 Demonstrate knowledge of image-generating 
devices, their resulting image types, and how to 
access resulting images in Photoshop.

2.5a Demonstrate knowledge of digital 
photography/cameras. 
2.5c Identify features of camera raw.

3.0 Understanding Adobe Photoshop 
3.1 Identify elements of the Photoshop user 
interface and demonstrate knowledge of their 
functions. 

3.1b Demonstrate knowledge of how to 
organize and customize the workspace.
3.1g Demonstrate knowledge of navigating 
images, rotating the canvas, and using pan 
and zoom. 

3.3 Demonstrate knowledge of importing, 
exporting, organizing, and saving. 

3.3a Demonstrate knowledge of how to 
import, export, and save files. 
3.3b Demonstrate knowledge of how to open 
scanned images, digital camera images, 
camera raw images, and video files in 
Photoshop.
 3.3c Demonstrate knowledge of how to 
optimize images for print and web.

3.4 Demonstrate knowledge of producing and 
reusing images.

3.4a Identify reasons for creating and reusing 
images.
3.4b Identify techniques used to produce 
reusable images.

See next page for 
activities



Lesson Topic Subtopic Objective Activity Notes
Lesson 7 
continued

Open Files in 
Photoshop CC

Open Files
DNG Files
Using the Mini Bridge

4.0 Manipulating Images by Using Adobe Photoshop
4.2 Use Photoshop guides and rulers.

4.2a Demonstrate knowledge of how to show 
and hide rulers.
4.2b Demonstrate knowledge of how to add 
and remove guides.
4.2c Demonstrate knowledge of guide 
properties.

Watch Session 1: Open 
Files in Photoshop CC 
[6 minutes]

Fill-in-the-Blanks 
Session 1: Questions 
11-12

Session 1 Project 6: From 
Digital Camera to 
Photoshop CC 

Session 2 Project 7: 
Importing, Exporting, 
Organizing, and Saving

Session 2 Project 8: 
Camera Raw

Lesson 8 Navigate 
Documents

Navigating within 
Documents

Rotating the Canvas
Keyboard Shortcuts for 

Navigation

3.0 Understanding Adobe Photoshop
3.1 Identify elements of the Photoshop user 
interface and demonstrate knowledge of their 
functions. 

3.1a Identify and label elements of the 
Photoshop interface. 
3.1b Demonstrate knowledge of how to 
organize and customize the workspace.  
3.1c Demonstrate knowledge of the functions 
of tools on the Tools panel. 
3.1g Demonstrate knowledge of navigating 
images, rotating the canvas, and using pan 
and zoom. 

4.0 Manipulating Images by Using Adobe Photoshop
4.3 Transform images.

4.3a Demonstrate knowledge of how to 
change the canvas size.
4.3b Demonstrate knowledge of how to rotate, 
flip, and straighten an image and how to 
rotate a canvas.

Watch Session 1: 
Navigate Documents [9 
minutes]

Fill-in-the-Blanks 
Session 1: Questions 
13-15

Session 1 Project 8: 
Canvas and Rotate

Lesson 9 Creating a New 
Document

Create New Document
New Document 

Window
Rulers and Guides
Lock and Unlock 

Guides
Guide Properties and 

Using Grid

4.0 Manipulating Images by Using Adobe Photoshop
4.2 Use Photoshop guides and rulers.

4.2a Demonstrate knowledge of how to show 
and hide rulers.
4.2b Demonstrate knowledge of how to add 
and remove guides.
4.2c Demonstrate knowledge of guide 
properties.
4.2d Demonstrate knowledge of how to 
change the measurement unit on rulers.

Watch Session 1: 
Creating a New 
Document [9 minutes]

Fill-in-the-Blanks 
Session 1: Questions 
16-19

Session 1 Lab 8: Activate 
Rulers

Session 1 Lab 9: Add a 
Guide



Lesson Topic Subtopic Objective Activity Notes
Lesson 10 Creating a New 

Document
See Lesson 9 See Lesson 9 Session 1 Project 9: 

Creating Documents 
and Using Rulers and 
Guides

Session 1 Project 10: 
Snap To It

Lesson 11 Color 
Theory and 
Management

Understanding RGB 
and CMYK

Difference between 
RGB and CMYK

Color Modes for 
Printing

Color Settings
Render Intent and Soft 

Proofing
Assign Profile and 

Convert to Profile
Color Management 

and Printer Setup

2.0 Identifying Design Elements When Preparing 
Images

2.1 Demonstrate knowledge of image resolution, 
image size, and image file format for web, video, 
and print. 

2.1b Demonstrate knowledge of differences 
between printed images and onscreen images.

2.4 Demonstrate knowledge of color correction 
using Photoshop.

2.4a Identify the differences between RGB and 
CMYK. 
2.4b Demonstrate knowledge of appropriate 
color settings for web, print, and video. 
2.4e Demonstrate knowledge of how to assess 
color in images by using the Info panel, the 
Histogram panel, and color views.
2.4f Demonstrate knowledge of how to select 
the appropriate color modes for web, print, 
and video.

3.0 Understanding Adobe Photoshop
3.5 Demonstrate an understanding of and select 
the appropriate features and options required to 
implement a color management workflow.

3.5a Given a term associated with color 
management, explain the meaning of that 
term.
3.5b Given an option in the Color Settings 
dialog box, explain the purpose of that option.
3.5c Explain the differences between, and 
how choosing either the Edit>Assign Profile 
or Edit>Convert to Profile commands affects 
an image.

Watch Session 1: 
Color Theory and 
Management [14 
minutes]

Fill-in-the-Blanks 
Session 1: Questions 
20-26

Session 1 Lab 10: 
Convert to Profile

Session 1 Project 11: 
Color Management

Lesson 12 Color 
Theory and 
Management

See Lesson 11 See Lesson 11 Session 1 Project 12: 
Color Theory and 
Management

Session 1 Project 13: 
Managing Color 
Settings



Lesson Topic Subtopic Objectives Activities Notes
Lesson 13 Understanding 

Image Formats
Graphic Types
Vector Formats
Print Raster and Web 

Raster Formats
Video Raster and 

Specialty Formats
Microsoft

2.0 Identifying Design Elements When Preparing 
Images

2.1 Demonstrate knowledge of image resolution, 
image size, and image file format for web, video, 
and print.

2.1a Demonstrate knowledge of how image 
resolution can change once an image is 
manipulated.
2.1d Identify the difference between image 
size measured in pixels and document size 
measured in inches.

2.4 Demonstrate knowledge of color correction 
using Photoshop.

2.4a Identify the differences between RGB and 
CMYK.

2.5 Demonstrate knowledge of image-generating 
devices, their resulting image types, and how to 
access resulting images in Photoshop.

2.5a Demonstrate knowledge of digital 
photography/cameras.
2.5b Demonstrate knowledge of scanning.
2.5c Identify features of camera raw.
2.5d Identify the differences between scanned 
images, digital camera images, and camera 
raw. 

2.6 Understand key terminology of digital images.
2.6a Demonstrate knowledge of key 
terminology of digital images.

5.0 Publishing Digital Images by Using Adobe 
Photoshop

5.1 Demonstrate knowledge of preparing images 
for web, print, and video.

5.1a Demonstrate knowledge of the elements 
of web images that need to be checked or 
confirmed prior to publishing to the web.
5.1b Demonstrate knowledge of creating a 
Web Photo Gallery.
5.1c Demonstrate knowledge of the elements 
of images that need to be checked or 
confirmed prior to print publishing.
5.1d Demonstrate knowledge of the 
elements of images that need to be checked 
or confirmed prior to publishing for use in 
videos.

Watch Session 1: 
Understanding Image 
Formats [5 minutes]

Fill-in-the-Blanks 
Session 1: Questions 
27-30

Session 1 Project 
14: Digital Image 
Terminology

Session 1 Project 15: 
Image File Formats

Session 1 Project 16: 
Print, Web, and Video

Lesson 14 Understanding  
Image Formats

See Lesson 13 See Lesson 13 Session 1 Project 16: 
Print, Web, and Video

Review and discuss 
Photoshop CC Session 
1



Lesson Topic Subtopic Objective Activity Notes
Lesson 15 Photoshop CC Session 1 

Post Assessment

Session 1 Notes

Lesson Topic Subtopic Objectives Activity Notes

Lesson 1 Session 2 Pre-Assessment

Lesson 2 Resolution and 
Cropping

Understand Resolution
   and Cropping
Canvas Size
Crop Image
Image Resolution
Crop
Resample Image
Straighten Image
Aspect Ratio
Fill and Rotate Canvas

2.0 Identifying Design Elements When Preparing 
Images

2.1 Demonstrate knowledge of image 
resolution, image size, and image file format 
for web, video, and print.

2.1a Demonstrate knowledge of how image 
resolution can change once an image is 
manipulated.

2.2 Demonstrate knowledge of design 
principles, elements, and image composition. 

2.2a Demonstrate knowledge of image 
composition and principles. 

2.6 Understand key terminology of digital 
images. 

2.6a Demonstrate knowledge of key 
terminology of digital images.

4.0 Manipulating Images by Using Adobe Photoshop
4.3 Transform images.

4.3a Demonstrate knowledge of how to 
change the canvas size.
4.3f Identify the differences between 
resampling and cropping.
4.3h Demonstrate knowledge of how to 
crop an image.

5.0 Publishing Digital Images by Using Adobe 
Photoshop 

5.1 Demonstrate knowledge of preparing 
images for web, print, and video. 

5.1c Demonstrate knowledge of the 
elements of images that need to be checked 
or confirmed prior to print publishing.

Watch Session 2: Resolution 
and Cropping [17 minutes]

Fill-in-the-Blanks Session 2: 
Questions 1-7

Session 2 Lab 1: Rule of Thirds 
Grid

Lesson 3 Resolution and 
Cropping

See Lesson 2 See Lesson 2 Session 2 Lab 2: Using the 
Straighten Tool

Session 2 Lab 3: Flipping 
Images

Session 2 Project 1: 
Resolution and Cropping



Lesson Topic Subtopic Objectives Activity Notes

Lesson 1 Session 2 Pre-Assessment

Lesson 2 Resolution and 
Cropping

Understand Resolution
   and Cropping
Canvas Size
Crop Image
Image Resolution
Crop
Resample Image
Straighten Image
Aspect Ratio
Fill and Rotate Canvas

2.0 Identifying Design Elements When Preparing 
Images

2.1 Demonstrate knowledge of image 
resolution, image size, and image file format 
for web, video, and print.

2.1a Demonstrate knowledge of how image 
resolution can change once an image is 
manipulated.

2.2 Demonstrate knowledge of design 
principles, elements, and image composition. 

2.2a Demonstrate knowledge of image 
composition and principles. 

2.6 Understand key terminology of digital 
images. 

2.6a Demonstrate knowledge of key 
terminology of digital images.

4.0 Manipulating Images by Using Adobe Photoshop
4.3 Transform images.

4.3a Demonstrate knowledge of how to 
change the canvas size.
4.3f Identify the differences between 
resampling and cropping.
4.3h Demonstrate knowledge of how to 
crop an image.

5.0 Publishing Digital Images by Using Adobe 
Photoshop 

5.1 Demonstrate knowledge of preparing 
images for web, print, and video. 

5.1c Demonstrate knowledge of the 
elements of images that need to be checked 
or confirmed prior to print publishing.

Watch Session 2: Resolution 
and Cropping [17 minutes]

Fill-in-the-Blanks Session 2: 
Questions 1-7

Session 2 Lab 1: Rule of Thirds 
Grid

Lesson 3 Resolution and 
Cropping

See Lesson 2 See Lesson 2 Session 2 Lab 2: Using the 
Straighten Tool

Session 2 Lab 3: Flipping 
Images

Session 2 Project 1: 
Resolution and Cropping

Session 2 [Approximately 7 hours]



Lesson Topic Subtopic Objective Activity Notes
Lesson 4 Evaluate 

Images
What is a Histogram?
Histogram Panel
Histogram on Camera

2.0 Identifying Design Elements When Preparing 
Images

2.4 Demonstrate knowledge of color correction 
using Photoshop.

2.4c Demonstrate knowledge of how to 
analyze and change the tonal range of an 
image by using a histogram.
2.4d Demonstrate knowledge of how to 
interpret color in an image by using the 
Histogram panel.
2.4e Demonstrate knowledge of how to 
assess color in images by using the Info 
panel, the Histogram panel, and color 
views.

Watch Session 2: Evaluate 
Images [7 minutes]

Fill-in-the-Blanks Session 2: 
Questions 8-10

Session 2 Lab 4: View RGB 
Channel

Session 2 Project 2: Using the 
Histogram Panel

Lesson 5 Basic Tonal 
Adjustments

Auto Adjustment 
Options

Manual Tonal 
Adjustments

Levels and Curves
Auto Color
Tonal Adjustments
Gradient Map
Photo Filter
Posterize
Match Color
Replace Color
Selective Color
Black and White
Adjustment Layers
Grayscale, Hue/

Saturation

2.0 Identifying Design Elements When Preparing 
Images

2.4 Demonstrate knowledge of color correction 
using Photoshop.

2.4c Demonstrate knowledge of how to 
analyze and change the tonal range of an 
image by using a histogram.

4.0 Manipulating Images by Using Adobe Photoshop
4.4 Adjust or correct the tonal range, color, or 
distortions of an image.

4.4a Identify auto correction methods and 
tools that are used for adjusting tonal range.
4.4b Identify adjustment menu tools that 
are used for adjusting tone.
4.4c Identify advanced adjustment and 
correction tools and when to use them.
4.4d Identify situations where using manual 
tonal adjustment is more appropriate than 
the auto controls.
4.4e Demonstrate knowledge of how to 
match, mix, and replace color by using a 
specific set of tools.
4.4f Demonstrate knowledge of how to 
adjust hue and saturation.
4.4g Demonstrate knowledge of how 
to enhance the visibility of a selected 
feature in an image, so the feature may 
be examined more accurately in medical 
or scientific research, architecture, or 
engineering.
4.4h Demonstrate knowledge of how to 
convert a color image to black and white.
4.4i Demonstrate knowledge of how to 
apply tonal and color changes by using the 
Adjustment layers.

Watch Session 2: Basic Tonal 
Adjustments [26 minutes]

Fill-in-the-Blanks Session 2: 
Questions 11-18



Lesson Topic Subtopic Objective Activity Notes
Lesson 6 Basic Tonal 

Adjustments
See Lesson 5 See Lesson 5 Session 2 Lab 5: Using the 

Curves Dialog Box

Session 2 Lab 6: Changing 
Channel

Session 2 Lab 7: Using the 
Gradient Map Dialog Box

Session 2 Lab 8: Using the 
Selective Color Dialog Box

Session 2 Lab 9: Using 
Grayscale

Session 2 Project 3: Auto 
Manual Adjustments

Lesson 7 Basic Tonal 
Adjustments

See Lesson 5 See Lesson 5 Session 2 Project 4: Image 
Adjustment

Session 2 Project 5: Tonal 
Adjustments

Lesson 8 Selections Create Basic Selections
Subtract, Transform 

Selection
Move Tool
Save, Fill Selection, 
   Copy
Selection Tools
Magic Wand
Quick Selection Tool
Advanced Selections
Feather Selection Tool
Color Range, Lasso  

Tool Selection
Hue and Saturation 

Adjustments
Create a Layer Mask
Copy and Paste  

Selection
Truer Edge Technology
Refine Edge Tool
Adjustment Layers

3.0 Understanding Adobe Photoshop
3.1 Identify elements of the Photoshop user 
interface and demonstrate knowledge of their 
functions. 

3.1e Demonstrate knowledge of the 
functions of the Properties panel.
3.1f Demonstrate knowledge of non-
destructive editing.

4.0 Manipulating Images by Using Adobe Photoshop
4.1 Demonstrate knowledge of working with 
selections.

4.1a Demonstrate knowledge of making 
selections using a variety of tools.
4.1b Demonstrate knowledge of saving, 
loading, and editing selections.
4.1c Demonstrate knowledge of moving, 
copying, and pasting selections.
4.1d Demonstrate knowledge of selection 
commands and how to modify selections.
4.1e Identify when to use feathering and 
anti-aliasing when making selections.
4.1f Identify tools that are used for 
selection. 
4.1g Demonstrate knowledge of how to 
make selections based on a color range.
4.1h Identify the methods or commands for 
undoing a selection.

4.3 Transform images.
4.3d Demonstrate knowledge of how to 
scale, rotate, or skew a selection.

4.4 Adjust or correct the tonal range, color, or 
distortions of an image. 

4.4f Demonstrate knowledge of how to 
adjust hue and saturation.
4.4i Demonstrate knowledge of how to 
apply tonal and color changes by using 
Adjustment layers.

Watch Session 2: Selections 
[28 minutes]

Fill-in-the-Blank Session 2: 
Questions: 19-26



Lesson Topic Subtopic Objective Activity Notes
Lesson 9 Selections See Lesson 8 See Lesson 8 Session 2 Lab 10: Marquee 

Selection Tools

Session 2 Lab 11: Create a 
Layer Mask

Session 2 Project 6: Selection 
Tools

Session 2 Project 7: Selection 
Techniques

Lesson 10 Selections See Lesson 8 See Lesson 8 Session 2 Project 8: Saving 
Selections

Session 2 Project 9: Advanced 
Selection Techniques

Lesson 11 Basic 
Retouching

Clone Stamp Tool
Healing Brush Tool
Spot Healing Brush 

Tool
Blending Tools
Remove Red Eye

4.0 Manipulating Images by Using Adobe Photoshop
4.5 Demonstrate knowledge of retouching and 
blending images.

4.5a Demonstrate knowledge of retouching 
and blending images.
4.5b Demonstrate knowledge of removing 
imperfections.
4.5c Demonstrate knowledge of how to 
clone part of an image.
4.5d Demonstrate knowledge of how to 
move or extend a selected object to a new 
location in the image.
4.5e Demonstrate knowledge of how to 
sharpen an image.

Watch Session 2: Basic 
Retouching [10 minutes]

Fill-in-the-Blank Session 2: 
Questions: 27-30

Session 2 Project 10: 
Retouching and Blending

Lesson 12 Content-Aware Content-Aware 
Features

Content-Aware Fill
Patch Tool
Content-Aware Move 

Tool

4.0 Manipulating Images by Using Adobe Photoshop
4.5 Demonstrate knowledge of retouching and 
blending images.

4.5a Demonstrate knowledge of how to 
remove red eye. 
4.5b Demonstrate knowledge of removing 
imperfections. 
4.5c Demonstrate knowledge of how to 
clone part of an image.  
4.5d Demonstrate knowledge of how to 
move or extend a selected object to a new 
location in the image.  
4.5e Demonstrate knowledge of how to 
sharpen an image.  
4.5f Demonstrate knowledge of how to 
“remove” an object from an image.  
4.5g Identify that blending determines how 
the pixels on a layer interact with the pixels 
on the layers below. 
4.5h Demonstrate knowledge of how to use 
blending tools.  
4.5i Demonstrate knowledge of opacity 
and fill. 
4.5j Demonstrate knowledge of when to use 
various blending mode options.

Watch Session 2: Content-
Aware [9 minutes]

Fill-in-the-Blank Session 2: 
Questions: 31

Session 2 Project 11: Content-
Aware Features



Lesson Topic Subtopic Objective Activity Notes
Lesson 13 Review and discuss 

Photoshop CC Session 2

Lesson 14 Photoshop CC Session 2 Post 
Assessment

Session 2 Notes



Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Session 3 Pre-Assessment

Lesson 2 Understand 
Layers

Flattened File
Layered File
Link Layers
Label Elements of 

Different Types
Merge Layers, Delete, 

Drag and Drop
Flatten Layer

3.0 Understanding Adobe Photoshop
3.1 Identify elements of the Photoshop user 
interface and demonstrate knowledge of 
their functions. 

3.1a Identify and label elements of the 
Photoshop interface.
3.1e Demonstrate knowledge of the 
functions of the Properties panel.
3.1f Demonstrate knowledge of non-
destructive editing. 

3.2 Demonstrate knowledge of layers and 
masks.

3.2a Identify and label elements of the 
different types of layers.
3.2d Demonstrate knowledge of how to 
edit layers.
3.2e Demonstrate knowledge of how to 
create layer groups and links.
3.2f Demonstrate knowledge of how to 
flatten layers. 
3.2g Identify the differences between a 
layered file and a flattened file.
3.2h Demonstrate knowledge of how to 
nest layers.
3.2i Demonstrate knowledge of how to 
add, delete, hide, show, lock, unlock, 
merge, duplicate, filter, and rename 
layers.

Watch Session 3: 
Understand Layers [10 
minutes]

Fill-in-the-Blank Session 3: 
Questions 1-3

Session 3 Lab 1: Link and 
Nest Layers

Session 3 Lab 2: Merge and 
Delete Layers

Session 3 Project 1: All 
About Layers

Lesson 3 Understand 
Layers

See Lesson 2 See Lesson 2 Session 3 Project 2: Working 
with Layer Comps

Lesson 4 Work with 
Layer Masks

Layer Masks
Properties Panel, 

Vector Mask
Nondestructive Masks, 

Levels

3.0 Understanding Adobe Photoshop 
3.2 Demonstrate knowledge of layers and 
masks. 

3.2a Identify and label elements of the 
different types of layers. 
3.2b Demonstrate knowledge of masks 
and modes.  
3.2c Demonstrate knowledge of how to 
create masks.

4.0 Manipulating Images by Using Adobe 
Photoshop

4.8 Demonstrate knowledge of filters. 
4.8f Demonstrate knowledge of Smart 
Objects and Smart Filters and how they 
enable nondestructive editing. 

Watch Session 3: Work with 
Layer Masks [12 minutes]

Fill-in-the-Blank Session 3: 
Questions 4-6

Session 3 Lab 3: To Refine 
an Edge

Session 3 Project 3: Working 
with Layer Masks

Session 3  [Approximately 11 hours]



Lesson Topic Subtopic Objective Activity Notes
Lesson 5 Work with 

Type
Type Tools
Character Panel, 

Options Bar
Kerning, Tracking, 

Leading, Type Layers
Layer Styles to Type
Anti-Aliasing
Fill and Opacity
Multilingual 

Dictionaries
Blending Mode
How Blending Modes 

Work
Blending Mode 

Options
Apply and Remove 

Layer Effects

2.0 Identifying Design Elements When Preparing 
Images

2.3 Demonstrate knowledge of typography.
2.3a Demonstrate knowledge of how 
background image can affect text.
2.3b Identify an appropriate font 
size, type, and color for a variety of 
situations. 
2.3c Identify an appropriate placement 
of text for a variety of situations.

4.0 Manipulating Images by Using Adobe 
Photoshop

4.7 Demonstrate knowledge of type.
4.7a Demonstrate knowledge of the 
functionality of each type panel option.
4.7b Demonstrate knowledge of 
functionality of type tools.
4.7c Demonstrate knowledge of the 
uses type layers.
4.7d Demonstrate knowledge of how to 
edit type.

4.8 Demonstrate knowledge of filters.
4.8b Demonstrate knowledge of how to 
apply and remove layer effects or layer 
styles. 
4.8c Demonstrate knowledge of how to 
apply layer styles to type.

Watch Session 3: Work with 
Type [23 minutes]

Fill-in-the-Blanks Session 3: 
Questions 7-12

Session 3 Lab 4: Editing Text

Session 3 Lab 5: Add a Layer 
Effect

Session 3 Lab 6: Working 
with Blending Modes

Lesson 6 Working with 
Type

See Lesson 5 See Lesson 5 Session 3 Project 4: 
Typography Basics in 
Photoshop CC

Lesson 7 Working with 
Type

See Lesson 5 See Lesson 5 Session 3 Project 5: Using 
Type

Session 3 Project 6: Working 
with Type



Lesson Topic Subtopic Objective Activity Notes
Lesson 8 Filters Use Filters, Sharpen 

Tools, Unsharp Mask
Use Blur Filters
Use Filter Gallery
Use Seven Lens 

Correction
Additive Grain
Vanishing Point Filter
Smart Objects and 

Smart Filters
Free Transform
Smart Objects
Embedded Smart 

Object
Smart Filters
Filter Gallery and Layer 

Masks

3.0 Understanding Adobe Photoshop 
3.1 Identify elements of the Photoshop user 
interface and demonstrate knowledge of 
their functions. 

3.1e Demonstrate knowledge of the 
functions of the Properties panel. 
3.1f Demonstrate knowledge of non-
destructive editing. 

3.2 Demonstrate knowledge of layers and 
masks.

3.2a Identify and label elements of the 
different types of layers.

3.4 Demonstrate knowledge of producing 
and reusing images.

3.4b Identify techniques used to 
produce reusable images.

4.0 Manipulating Images by Using Adobe 
Photoshop 

4.3 Transform Images.
4.3e Demonstrate knowledge of how to 
reposition or warp image elements. 

4.8 Demonstrate knowledge of filters. 
4.8a Demonstrate knowledge of how to 
use the Filter Gallery.
4.8b Demonstrate knowledge of how to 
apply and remove layer effects or layer 
styles. 
4.8c Demonstrate knowledge of how to 
apply layer styles to type. 
4.8d Demonstrate knowledge of using 
smart filters. 
4.8e Identify the appropriate filter to use 
for a variety of situations. 
4.8f Demonstrate knowledge of Smart 
Objects and Smart Filters and how they 
enable nondestructive editing. 
4.8g Demonstrate knowledge of editing 
images using the vanishing point filter. 
4.8h Demonstrate knowledge of editing 
images using Blur filters.

Watch Session 3: Filters [30 
minutes]

Fill-in-the-Blanks Session 3: 
Questions 13-19

Lesson 9 Filters See Lesson 8 See Lesson 8 Session 3 Lab 7: Add a Smart 
Filter

Session 3 Project 7: Using 
Filters

Session 3 Project 8: More 
Filters

Lesson 10 Filters See Lesson 8 See Lesson 8 Session 3 Project 9: Smart 
Objects

Session 3 Project 10: 
Keeping Things in 
Perspective



Lesson Topic Subtopic Objective Activity Notes
Lesson 11 Shape Tool 

and Pen Tool
Draw Using Shape Tool 

and Pen Tool
Create a Path
Photoshop Path
Create Shapes,  

Rounded Rectangle
Custom Shapes, Preset 

Shapes
Paint Tools, Brush 

Tools
Brush Tips
Brush Presets

4.0 Manipulating Images by Using Adobe 
Photoshop

4.3 Transform images.
4.3e Demonstrate knowledge of how to 
reposition or warp image elements.

4.6 Demonstrate knowledge of drawing and 
painting.

4.6a Demonstrate knowledge of 
drawing by creating vector layers and 
paths.
4.6b Demonstrate knowledge of how to 
edit a path.
4.6c Identify tools that are used for 
painting.
4.6d Identify tools that are used for 
drawing, or creating shapes.
4.6e Identify the purpose of an option 
from the Brushes panel.

Watch Session 3: Shape Tool 
and Pen Tool: Draw Using 
Shape Tool and Pen Tool- 
Bush Presets [21 minutes]

Fill-in-the-Blanks Session 3: 
Questions 20-23

Session 3 Lab 8: Make a 
Custom Shape

Session 3 Lab 9: Create a 
Brush Preset

Lesson 12 Shape Tool 
and Pen Tool 
continued

Color Blending Tools
Blending Mode for 

Layers, Pencil Tool
Mixer Brush
History Panel and 

History Brush
Puppet Warp
Batch Processing

4.0 Manipulating Images by Using Adobe 
Photoshop

4.1 Demonstrate knowledge of working 
with selections.

4.1i Demonstrate knowledge of how to 
composite images. 
4.1j Demonstrate knowledge of batch-
processing techniques. 

4.3 Transform images.
4.3e Demonstrate knowledge of how to 
reposition or warp image elements.

4.6 Demonstrate knowledge of drawing and 
painting.

4.6c Identify tools that are used for 
painting.
4.6f Demonstrate knowledge of color 
blending.

Watch Session 3: Shape 
Tool and Pen Tool: Color 
Blending Tools- Batch 
Processing [22 minutes]

Fill-in-the-Blanks Session 3: 
Questions 24-27

Session 3 Lab 10: Add 
Puppet Warp

Session 3 Lab 11: Set up an 
Action

Session 3 Lab 12: Create a 
Batch



Lesson Topic Subtopic Objective Activity Notes
Lesson 13 Shape Tool 

and Pen Tool 
continued

Auto-Align Layers
Auto-Blend Layers
32-Bit Merge to HDR
Publish Digital Images
Publish to Web
Publish for Use in 

Videos
Web Photo Gallery
Automatic Asset 

Generation
Real Time Image 

Generation

2.0 Identifying Design Elements When Preparing 
Images

2.1 Demonstrate knowledge of image 
resolution, image size, and image file 
format for web, video, and print.

2.1e Demonstrate knowledge of image 
optimization with regards to preparing 
images for web, video, or print. 

2.4 Demonstrate knowledge of color 
correction using Photoshop.

2.4h Demonstrate knowledge of 32-bit 
HDR imaging. 

3.0 Understanding Adobe Photoshop 
3.3 Demonstrate knowledge of importing, 
exporting, organizing, and saving.

3.3a Demonstrate knowledge of how to 
import, export, and save files.
3.3c Demonstrate knowledge of how to 
optimize images for print and web.

4.0 Manipulating Images by Using Adobe 
Photoshop

4.1 Demonstrate knowledge of working 
with selections.

4.1i Demonstrate knowledge of how to 
composite images. 

5.0 Publishing Digital Images by Using Adobe 
Photoshop

5.1 Demonstrate knowledge of preparing 
images for web, print, and video.

5.1a Demonstrate knowledge of the 
elements of web images that need 
to be checked or confirmed prior to 
publishing to the web
5.1b Demonstrate knowledge of 
creating a Web Photo Gallery.
5.1c Demonstrate knowledge of the 
elements of images that need to be 
checked or confirmed prior to print 
publishing.
5.1d Demonstrate knowledge of 
the elements of images that need to 
be checked or confirmed prior to 
publishing for use in videos.

Watch Session 3: Shape Tool 
and Pen Tool: Auto-Align 
Layers- Real Time Image 
Generation [23 minutes]

Fill-in-the-Blanks Session 3: 
Questions 28-30

Session 3 Lab 13: Use 
Photoshop Layers

Session 3 Lab 14: Auto-Align 
Image Layers

Session 3 Lab 15: Create a 
Web Gallery

Lesson 14 Shape Tool 
and Pen Tool 

See Lessons 11 and 12 See Lessons 11 and 12 Session 3 Project 11: Using 
the Pen Tool

Session 3 Project 12: 
Drawing

Lesson 15 Shape Tool 
and Pen Tool

See Lessons 11 and 12 See Lessons 11 and 12 Session 3 Project 15: Custom 
Brushes

Session 3 Project 16: Puppet 
Warp

Lesson 16 Shape Tool 
and Pen Tool

See Lesson 12 See Lesson 12 Session 3 Project 13: 
Painting



Lesson Topic Subtopic Objectives Activity Notes
Lesson 17 Shape Tool 

and Pen Tool
See Lesson 12 See Lesson 12 Session 3 Project 19: Web 

Gallery

Lesson 18 Shape Tool 
and Pen Tool

See Lessons 12 See Lesson 12 Session 3 Project 14: Paint 
and Brush Tools

Lesson 19 Shape Tool 
and Pen Tool

See Lesson 12 and 13 See Lesson 12 and 13 Session 3 Project 17: 
Photoshop Actions

Session 3 Project 18: Merge 
to HDR

Lesson 20 Review and discuss 
Photoshop CC Session 3

Lesson 21 Photoshop CC Session 3 
Post Assessment

Session 3 Notes



Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Entire Course Entire Course All Objectives Photoshop CC Master 

Project

Lesson 2 Entire Course Entire Course All Objectives Photoshop CC Master 
Project

Lesson 3 Entire Course Entire Course All Objectives Photoshop CC Master 
Project

Lesson 4 Entire Course Entire Course All Objectives Photoshop CC Master 
Project

Lesson 5 Entire Course Entire Course All Objectives Photoshop CC Master 
Project

Lesson 6 Entire Course Entire Course All Objectives MasterExam

Lesson 7 Entire Course Entire Course All Objectives MasterExam

Notes

Master Level Lesson Plans [Approximately 6-12 hours]
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Intro to Photoshop CC
Project Requirements

Project Specifications

The Capture
Import Photos

Metadata

Functions of a Camera

Scanning an Image

Scanned Images

Photoshop Workspace

Configure Image Display

Panels

Customize Workspace

Save Custom Workspace

Customize Keyboard

Customize Menus

Deleting Presets and Favorites

Open Files in Photoshop CC
Open Files

DNG Files

Using the Mini Bridge

Navigate Documents
Navigating within Documents

Rotating the Canvas

Keyboard Shortcuts for Navigation

Creating a New Document
Create New Document

New Document Window

Rulers and Guides

Lock and Unlock Guides

Guide Properties and Using Grid

Color Theory and Management
Understanding RGB and CMYK

Difference between RGB and CMYK

Color Modes for Printing

Color Settings

Render Intent and Soft Proofing

Assign Profile and Convert to Profile

Color Management and Printer Setup

Understanding Image Formats
Graphic Types

Vector Formats

Print Raster and Web Raster Formats

Video Raster and Specialty Formats

Microsoft

Smart Filters

Filter Gallery and Layer Masks

Photoshop CC Session 1 Outline 
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Resolution and Cropping
Understand Resolution and Cropping

Canvas Size

Crop Image

Image Resolution

Crop

Resample Image

Straighten Image

Aspect Ratio

Fill and Rotate Canvas

Evaluate Image
What is a Histogram?

Histogram Panel

Histogram on Camera

Basic Tonal Adjustments
Auto Adjustment Options

Manual Tonal Adjustments

Levels and Curves

Auto Color

Tonal Adjustments

Gradient Map

Photo Filter

Posterize

Match Color

Replace Color

Selective Color

Black and White

Adjustment Layers

Grayscale, Hue/Saturation

Photoshop CC Session 2 Outline 
Selections

Create Basic Selections

Subtract, Transform Selection

Move Tool

Save, Fill Selection, Copy

Selection Tools

Magic Wand

Quick Selection Tool

Advanced Selections

Feather Selecton Tool

Color Range, Lasso Tool Selection

Hue and Saturation Adjustments

Create a Layer Mask

Copy and Paste Selection

Truer Edge Technology

Refine Edge Tool

Adjustment Layers

Basic Retouching
Clone Stamp Tool

Healing Brush Tool

Spot Healing Brush Tool

Blending Tools

Remove Red Eye

Content-Aware
Content-Aware Features

Content-Aware Fill

Patch Tool

Content-Aware Move Tool
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Understand Layers
Flattened File

Layered File

Link Layers

Label Elements of Different Types

Merge Layers, Delete, Drag and Drop

Flatten Layer

Work with Layer Masks
Layer Masks

Properties Panel, Vector Mask

Nondestructive Masks, Levels

Work with Type
Type Tools

Character Panel, Options Bar

Kerning, Tracking, Leading, Type Layers

Layer Styles to Type

Anti-Aliasing

Fill and Opacity

Multilingual Dictionaries

Blending Mode

How Blending Modes Work

Blending Mode Options

Apply and Remove Layer Effects

Filters
Use Filters, Sharpen Tools, Unsharp Mask

Use Blur Filters

Use Filter Gallery

Use Seven Lens Correction

Additive Grain

Vanishing Point Filter

Smart Objects and Smart Filters

Free Transform

Smart Objects

Embedded Smart Object

Photoshop CC Session 3 Outline 
Shape Tool and Pen Tool

Draw Using Shape Tool and Pen Tool

Create a Path

Photoshop Path

Create Shapes, Rounded Rectangle

Custom Shapes, Preset Shapes

Paint Tools, Brush Tools

Brush Tips

Brush Presets

Color Blending Tools

Blending Mode for Layers, Pencil Tool

Mixer Brush

History Panel and History Brush

Puppet Warp

Batch Processing

Auto-Align Layers

Auto-Blend Layers

32-Bit Merge to HDR

Publish Digital Images

Publish to Web

Publish for Use in Videos

Web Photo Gallery

Automatic Asset Generation

Real Time Image Generation
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Shortcut Keys
Command Key Combination

New Ctrl+N

Open Ctrl+O

Browse in Bridge Shift+Ctrl+O

Open As Alt+Shift+Ctrl+O

Close Ctrl+W

Close All Alt+Ctrl+W

Close and Go to Bridge Shift+Ctrl+W

Save Ctrl+S

Save As Shift+Ctrl+S

Save for Web Alt+Shift+Ctrl+S

Revert F12

File Info Alt+Shift+Ctrl+I

Print Ctrl+P

Print One Copy Alt+Shift+Ctrl+P

Exit Ctrl+Q

Undo/Redo Ctrl+Z

Step Forward Shift+Ctrl+Z

Step Backward Alt+Ctrl+Z

Fade Shift+Ctrl+F

Cut Ctrl+X or F2

Copy Ctrl+C or F3

Copy Merged Shift+Ctrl+C

Paste Ctrl+V or F4

Paste into Place Shift+Ctrl+V

Paste Into Alt+Shift+Ctrl+V

Free Transform Ctrl+T

Transform Again Shift+Ctrl+T

Color Settings Shift+Ctrl+K

Keyboard Shortcuts Alt+Shift+Ctrl+K

Preferences Ctrl+K

Levels Ctrl+L

Curves Ctrl+M

Hue/Saturation Ctrl+U

Color Balance Ctrl+B

Black & White Alt+Shift+Ctrl+B

Invert Ctrl+I

Desaturate Shift+Ctrl+U

Auto Tone Shift+Ctrl+L

Auto Contrast Alt+Shift+Ctrl+L

Auto Color Shift+Ctrl+B

Image Size Alt+Ctrl+I

Canvas Size Alt+Ctrl+C

New Layer Shift+Ctrl+N

New Layer via Copy Ctrl+J

Command Key Combination
New Layer via Cut Shift+Ctrl+J

Group Layers Ctrl+G

Ungroup Layers Shift+Ctrl+G

Bring to Front Shift+Ctrl+]

Bring Forward Ctrl+]

Send Backward Ctrl+[

Send to Back Shift+Ctrl+[

Merge Layers Ctrl+E

Merge Visible Shift+Ctrl+E

Select All Ctrl+A

Deselect Ctrl+D

Reselect Shift+Ctrl+D

Select Inverse Shift+Ctrl+I

Select All Layers Alt+Ctrl+A

Modify Feather Shift+F6

Last Filter Ctrl+F

Zoom In Ctrl+Plus Sign (+)

Zoom Out Ctrl+Hyphen (-)

Fit on Screen Ctrl+0

Show Grid Ctrl+Apostrophe (‘)

Show Guides Ctrl+Semicolon (;)

Rulers Ctrl+R

Snap Shift+Ctrl+Semicolon (;)

Lock Guides Alt+Ctrl+Semicolon (;)

Actons Window F9

Brush Window F5

Color Window F6

Info Window F8

Layers Window F7

Photoshop Help F1

Move Tool V

Rectangle Marquee Tool M

Lasso Tool L

Quick Selection Tool W

Eyedropper Tool I

Crop Tool C

Spot Healing Brush J

Brush Tool B

Clone Stamp Tool S

History Brush Tool Y

Eraser Tool E

Gradient Tool G

Rectangle Tool U

Pen Tool P
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Shortcut Keys for Mac
Command Key Combination

New Cmd+N

Open Cmd+O

Browse in Bridge Opt+Cmd+O or Shift+Cmd+O

Close Cmd+W

Close All Opt+Cmd+W

Close and Go to Bridge Shift+Cmd+W

Save Cmd+S

Save As Shift+Cmd+S or Opt+Cmd+S

Save for Web Opt+Shift+Cmd+S

Revert F12

File Info Opt+Shift+Cmd+I

Print Cmd+P

Print One Copy Opt+Shift+Cmd+P

Quit Photoshop Cmd+Q

Undo/Redo Cmd+Z or F1

Step Forward Shift+Cmd+Z

Step Backward Opt+Cmd+Z

Fade Shift+Cmd+F

Cut Cmd+X or F2

Copy Cmd+C or F3

Copy Merged Shift+Cmd+C

Paste Cmd+V or F4

Paste in Place Shift+Cmd+V

Paste Into Opt+Shift+Cmd+V

Free Transform Cmd+T

Transform Again Shift+Cmd+T

Color Settings Shift+Cmd+K

Keyboard Shortcuts Opt+Shift+Cmd+K

Preferences Cmd+K

Levels Cmd+L

Curves Cmd+M

Hue/Saturation Cmd+U

Color Balance Cmd+B

Black & White Opt+Shift+Cmd+B

Invert Cmd+I

Desaturate Shift+Cmd+U

Auto Tone Shift+Cmd+L

Auto Contrast Opt+Shift+Cmd+L

Auto Color Shift+Cmd+B

Image Size Opt+Cmd+I

Canvas Size Opt+Cmd+C

New Layer Shift+Cmd+N

New Layer via Copy Cmd+J

New Layer via Cut Shift+Cmd+J

Command Key Combination
Create/Release Clipping Mask Opt+Cmd+G

Group Layers Cmd+G

Ungroup Layers Shift+Cmd+G

Bring to Front Shift+Cmd+]

Bring Forward Cmd+]

Send Backward Cmd+[

Send to Back Shift+Cmd+[

Merge Layers Cmd+E

Merge Visible Shift+Cmd+E

Select All Cmd+A

Deselect Cmd+D

Reselect Shift+Cmd+D

Select Inverse Shift+Cmd+I or Shift+F7

Select All Layers Opt+Cmd+A

Modify Feather Shift+F6

Last Filter Cmd+F

Zoom In Cmd+Plus Sign (+) or 

Zoom Out Cmd+Hyphen (-)

Fit on Screen Cmd+0

Show Grid Cmd+Apostrophe (‘)

Show Guides Cmd+Semicolon (;)

Rulers Cmd+R

Snap Shift+Cmd+Semicolon (;)

Lock Guides Opt+Cmd+Semicolon (;)

Actions Window Opt+F9

Brush Window F5

Color Window F6

Info Window F8

Layers Window F7

Photoshop Help Cmd+/ or Shift+Cmd+/

Move Tool V

Rectangle Marquee Tool M

Lasso Tool L

Quick Selection Tool W

Eyedropper Tool I

Crop Tool C

Spot Healing Brush J

Brush Tool B

Clone Stamp Tool S

History Brush Tool Y

Eraser Tool E

Gradient Tool G

Rectangle Tool U

Pen Tool P
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